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This manual is part of a set of Color Controller E-820

 

™

 

 documentation that includes 
the following manuals for users and system administrators:

• The

 

 Quick Start Guide

 

 summarizes the steps for configuring the E-820 and printing. 
It also describes how to access the online documentation. 

• The

 

 User Software Installation Guide 

 

describes how to install software from the 
User Software CD to enable users to print to the E-820, and also describes setting 
up printing connections to the E-820.

• The

 

 Configuration Guide 

 

explains basic configuration and administration of the 
E-820 for the supported platforms and network environments. It also includes 
guidelines for setting up UNIX, Windows NT 4.0/2000, and Novell NetWare 
servers to provide printing services to users. 

• The

 

 Printing Guide

 

 describes the printing features of the E-820 for users who send 
jobs from their computers.

• The

 

 Color Guide 

 

provides information on managing the color output of the E-820. 
It explains how to calibrate your copier and take advantage of the EFI Fiery 
ColorWise

 

®

 

 color management system, as well as features in ColorWise Pro Tools

 

™

 

. 

• The

 

 Fiery Color Reference 

 

addresses concepts and issues associated with managing 
color output of the E-820 and outlines key workflow scenarios. In addition, it offers 
information on printing color documents from popular Microsoft Windows and 
Apple Mac OS applications.

• The

 

 Job Management Guide 

 

explains the functions of the job management utilities, 
including EFI Command WorkStation

 

™ 

 

and EFI Fiery DocBuilder

 

 

 

Pro

 

™

 

, and how 
you can use them to monitor and control jobs on the E-820. This manual is 
intended for an operator or administrator, or a user with the necessary access 
privileges, who monitors and manages job flow, performs color calibration, and 
troubleshoots problems that may arise.

•

 

Release Notes

 

 provide last-minute product information and workarounds for some of 
the problems you may encounter.
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FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void 
the user’s authority to operate this equipment. 

Class A Compliance

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, and uses, 
and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 
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Industry Canada Class A Notice

This Class A digital apparatus complies with Canadian ICES-003.

Avis de Conformation Classe A de l’Industrie Canada 
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RFI Compliance Notice
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License
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the person or entity all of the Software and Documentation (including all copies, updates, upgrades, prior versions, component parts, the media and printed 
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or reverse engineer the Software.

Proprietary Rights
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suppliers. Except as stated above, this Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), 
or any other rights, franchises or licenses in respect of the Software. You may not adopt or use any trademark or trade name which is likely to be similar to or 
confusing with that of EFI or any of its suppliers or take any other action which impairs or reduces the trademark rights of EFI or its suppliers.



              
Confidentiality

You agree to hold the Software in confidence, disclosing the Software only to authorized users having a need to use the Software as permitted by this Agreement 
and to take all reasonable precautions to prevent disclosure to other parties.

Remedies and Termination

Unauthorized use, copying or disclosure of the Software, or any breach of this Agreement will result in automatic termination of this license and will make available 
to EFI other legal remedies. In the event of termination, you must destroy all copies of the Software and all of its component parts. All provisions of this Agreement 
relating to disclaimers of warranties, limitation of liability, remedies, damages, and EFI’s proprietary rights shall survive termination.

Limited Warranty and Disclaimer

EFI warrants to the original purchaser (“Customer”) for thirty (30) days from the date of original purchase from EFI or its authorized retailer that the Software 
will perform in substantial conformance to the Documentation when the Product is used as authorized by EFI’s specifications. EFI warrants the media containing 
the Software against failure during the above warranty period. EFI makes no warranty or representation that the Software will meet your specific requirements, 
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U.S. Government Restricted Rights:
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General
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xi About this manual

           
This manual explains how to manage color output on the Color Controller E-820, 
and provides information on calibration and color profiles.

This manual is part of a set of documentation that includes manuals for users and 
system administrators. The other manuals should be available at your site—refer to 
them for a complete description of your Color Controller E-820.

NOTE: The term “E-820” is used in this manual to refer to the Color Controller E-820. 
“Aero” is used in illustrations throughout this manual to represent the E-820. 

About this manual
This manual is organized to supply you with key information about managing 
the color output of your E-820. 

• Chapter 1 describes the E-820 print options and how to get the best color results. 

• Chapter 2 covers various methods of calibrating the E-820.

• Chapter 3 takes you through the features of ColorWise Pro Tools. ColorWise Pro 
Tools include Profile Manager, used to manage color profiles on the E-820, and 
Color Editor, which allows you to customize simulation and output profiles. This 
chapter also describes Spot On, which allows you to define CMYK equivalents for 
spot colors.

• Appendix A provides information about color measurement instruments, available 
as separately purchased options.

• Appendix B describes the Simple ASCII File Format (SAIFF), which can be used to 
import toner density measurements from measurement devices.

• The Fiery Color Reference Glossary defines words in bold—for example, output 
profile—that appear throughout this manual. Color terms and concepts such as 
“color space,” “spot color,” “gamut,” and “source profile” are used throughout this 
manual. If you are new to desktop color, or if any terms are unfamiliar, check the 
Glossary.

Introduction



 

xii Introduction

                         
Key features of ColorWise
ColorWise is the color management system (CMS) designed and built into the 
E-820 and designed to provide both casual and expert users with the best color output 
for a variety of purposes. The ColorWise default settings provide great out-of-box 
color from many Windows and Mac OS applications. This allows casual users to 
achieve good quality output without knowing about or changing any color settings 
on the E-820.

For consistent color, calibrate the E-820 on a regular basis. ColorWise Pro Tools 
include a simple-to-use calibrator, which allows you to calibrate using either the 
scanning unit that is part of the copier or an optional spectrophotometer or 
densitometer (see Chapter 2).

ColorWise features let you modify printing results. Depending on your particular 
needs, you can:

• Set the behavior of CMYK printing to emulate DIC, Euroscale, and SWOP offset 
press standards.

• Match PANTONE and other spot colors for the best match when printed using 
four-color press conditions or when printed using presses with extra, custom plates.

• Select a color rendering dictionary (CRD), also called a rendering style, for RGB 
printing. CRDs allow for rich, saturated printing of presentation graphics; smooth, 
accurate printing of photographs; and relative or absolute colorimetric rendering for 
specialized needs.

• Define the source of incoming RGB color data for better screen matching and 
provide for better color conversion of RGB data with no source information.

• Define whether RGB data is converted into the full gamut of the copier or whether 
it is first converted into the gamut of another device, such as a press standard. This 
feature is very helpful for making one device behave like another. It is also useful for 
evaluating the appearance of the RGB file under different printing conditions 
without having to reprocess the RGB data each time. 



 

xiii Key features of ColorWise

          
ColorWise color management (ColorWise) offers an open color architecture, letting 
users customize the E-820 to meet new printing needs as they arise. ColorWise 
supports ICC profiles, which are industry standard color profiles that describe the 
color behavior of a device. Downloading ICC profiles to the E-820 enables the E-820 
to simulate a custom press (or another copier), as well as accurately print colors from a 
particular monitor or a scanner. In addition, you can create customized ICC profiles 
for the copier.

ColorWise also lets you use any Status T densitometer by importing data in a standard 
file format (see Appendix B). In this case, it is important to note that the quality of the 
instrument used will determine the quality of the calibration.
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1-1 Managing color on the E-820

                   
The first part of this chapter describes the options available from the ColorWise 
color management system and explains how to customize the color settings for your 
particular needs. It provides descriptions of the preset ColorWise default settings and 
covers additional options for users who need to customize ColorWise.

Beginning on page 1-17 is a detailed explanation of what a PostScript Level 2 or 3 
printer driver does, as well as information on the capabilities of various printer drivers 
and instructions for setting color options with the PostScript drivers for Windows and 
Mac OS computers.

Managing color on the E-820
To modify E-820 printing behavior, do any of the following:

• Select ColorWise options for an individual print job using menus that appear in the 
printer driver.

• Select most ColorWise options as server defaults from the Color Setup application 
in ColorWise Pro Tools (see page 3-36). Defaults can also be set from E-820 Setup 
or from the Control Panel, as described in the Configuration Guide. These defaults 
will apply to all subsequent print jobs unless you override them.

• Select some ColorWise options, particularly default ICC profile settings and 
calibration options, from ColorWise Pro Tools. These options include default 
Simulation Profile (see page 1-9), Simulation Method (see page 1-10), Appear in 
Driver as (see page 3-7), default Source Profile (see page 1-7), RGB Separation 
(see page 1-8), and associated calibration set (see page 2-4).

Applications can generate color data for the E-820 in many different color spaces. 
The most common type of color data produced from office applications is RGB, 
while prepress applications generally produce CMYK data. Desktop applications can 
also generate spot colors, such as PANTONE colors. To complicate matters, a single 
page may contain a mix of RGB, CMYK, and spot colors. The E-820 lets users control 
the printing of these mixed-color documents with features that apply specifically to 
RGB, CMYK, or spot color data.

Chapter 1:
E-820 Color 
Management
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1-2 E-820 Color Management

       
E-820 color management generates CMYK data to be sent to the copier. 

The following diagram illustrates the print options in the E-820 color management 
process that affect color data conversions. You access these print options when you 
send a print job to the E-820. Most of these options and settings are described in 
subsequent sections of this chapter.

RGB Source Profile is the only color option that applies strictly to RGB color data. 
The other options that affect RGB color also affect the more rarely used Lab, XYZ, 
and other calibrated color spaces.

NOTE: For users who are familiar with PostScript 3 color, RGB Source Profile affects 
all CIEBasedABC color spaces (if the source space is RGB). If you send CMYK data 
to the E-820 in CIEBasedDEFG format, for example, by choosing PostScript Color 
Management in Adobe Photoshop, the E-820 Rendering Style selection—which 
normally affects only RGB data—will also affect this CMYK data. 

You can specify settings for the following options via print options when you send a 
job to the E-820. Some can also be set as defaults by the administrator during E-820 
Setup or using ColorWise Pro Tools. Settings specified via print options override the 

RGB Source Profile
    Gamma
    Phosphors
    White Point

Rendering Style (CRD)
Brightness
Pure Black Text/Graphics
RGB Separation
Output profile

Color data sent 
to copier

E-820 
color 

processor

RGB data

CMYK data

Spot color data Spot Color Matching

CMYK Simulation Profile

CMYK Simulation Method
Brightness
Pure Black Text/Graphics
Combine Separations
Output profile
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1-3 Managing color on the E-820

                
defaults. Some options are available only with the Fiery Graphic Arts Package, which is 
available as a separately purchased option.  

E-820 color print option What it does

Color Mode
CMYK/Grayscale
or
Print Mode (Windows 98)
Standard Color/Expert Color/Grayscale

Specifies the output color space of the job. Select CMYK, Standard Color, or 
Expert Color for a full-color document. 

Combine Separations
On/Off

Specifies whether to print separated CMYK data as a single, four-color 
composite document (see page 1-5). If you have the Fiery Graphic Arts 
Package, you can combine an unlimited number of spot color separations 
along with the CMYK separations. 

Rendering Style 
Photographic/Presentation/Relative 
Colorimetric/Absolute Colorimetric
(Default set at Setup)

Applies a E-820 color rendering dictionary (CRD) to RGB data (see 
page 1-6), or to any incoming data with a PostScript source color space 
definition, including CMYK.

Brightness 
85% Lightest to 115% Darkest

Performs a color adjustment on all color channels to make the printed 
output lighter or darker.

RGB Source Profile
EFIRGB/sRGB 
(PC)/Apple Standard/Other/
Source 1-10/None 
(Default set at Setup or with ColorWise Pro 
Tools)

Applies an RGB source space definition to RGB data (see page 1-7). If you 
choose the Other setting, you can specify particular settings for Gamma, 
Phosphors, and White Point. See the corresponding options in this table. This 
option, along with Gamma, Phosphors, and White Point, only affects 
DeviceRGB or calibrated RGB color spaces.

(Other) Gamma 
1.0/1.2/1.4/1.6/1.8/2.0/2.2/2.4/2.6/2.8/3.0

Applies the specified gamma value to the RGB source space definition (see 
page 1-7). To use this print option, you must choose Other as the RGB Source 
setting.

(Other) Phosphors 
Hitachi EBU/Hitachi-Ikegami/NTSC/
Radius Pivot/SMPTE/Trinitron

Applies the specified phosphor (monitor type) information to the RGB 
source space definition (see page 1-7). To use this print option, you must 
choose Other as the RGB Source setting.

(Other) White Point 
5000 K (D50)/5500 K/6500 K (D65)/
7500 K/9300 K

Applies the specified white point value to the RGB source color space 
definition (see page 1-7). To use this print option, you must choose Other as 
the RGB Source setting.



11-4 E-820 Color Management
RGB Separation
Output/Simulation

Determines which CMYK color space your original RGB data will be 
separated into—CMYK for the copier (Output) or CMYK for a specified 
simulation (Simulation) (see page 1-8). It is important to note that when RGB 
Separation is set to Simulation, RGB colors are affected by CMYK Simulation 
Profile and CMYK Simulation Method.

CMYK Simulation Profile
SWOP-Coated/DIC/Euroscale/
Simulation 1-10/Match Copy/None
(Default set at Setup or in ColorWise Pro 
Tools)

Adjusts CMYK color data to simulate an offset press standard or a custom 
color gamut defined at your site. The Match Copy setting bypasses E-820 
calibration to match a copy made from the copier glass. Choosing None 
bypasses simulation (see page 1-9). 

NOTE: Some of the Simulation settings have slightly different names depending 
on the model of copier.

CMYK Simulation Method
Quick/Full (Source GCR)/Full (Output 
GCR)
(Default in Setup or ColorWise Pro Tools)

Quick simulation applies one-dimensional transfer curves that adjust output 
density only. The Full simulations apply colorimetric transformations that 
adjust hue as well as output density (see page 1-10).

Paper Simulation
No/Yes

Adjusts color output to compensate for the white point value of the paper 
stock used. For example, newsprint has a darker white point than white bond 
paper. This option is only available as part of the Fiery Graphic Arts Package.

Output Profile The output profile is applied to all data in the print job (see page 1-11). 
User-defined output profiles can be downloaded to the E-820 using 
ColorWise Pro Tools (see Chapter 3).

Pure Black Text/Graphics
On/Off 
(Default in Setup)

The On setting optimizes the quality of black text and line art output. 
(see page 1-11).

Black Overprint
On/Off (Default in Setup)

The On setting overprints black text and text/graphics placed on colored 
backgrounds. Overprinting colored backgrounds eliminates white gaps and 
reduces halo effects or misregistration of colors. The On setting automatically 
activates the Pure Black Text/Graphics option (see page 1-11).

Black Overprint Style
Text/Text & Graphics

Specifies whether black overprinting should apply to text only or to both text 
and graphics. For this option to take effect, the Black Overprint option must 
be set to On (see page 1-12).

E-820 color print option What it does
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Detailed explanations of how these and other settings affect your print jobs are 
provided in subsequent sections of this chapter.

Combine Separations
The Combine Separations setting specifies how to print separated CMYK data. If you 
have the Fiery Graphic Arts Package option, you can combine an unlimited number of 
spot color separations along with the CMYK separations. The Combine Separations 
options are:

• Off prints each separation individually.

• On combines separations as a single, composite-color document, and constrains the 
settings of the following print options: Color Mode (CMYK), Rendering Style 
(None), Pure Black Text/Graphics (Off ), Spot Color Matching (Off ).

For information about using the Combine Separations option with applications, see 
the Fiery Color Reference.

Spot Color Matching
On/Off 
(Default in Setup or ColorWise Pro Tools)

The On setting enables E-820-defined matching of spot colors to their best 
CMYK equivalents. If you have the Fiery Graphic Arts Package installed, you 
can use Spot On to manage and edit these spot color matches (see page 3-21). 
Off instructs the E-820 to match color output to a CMYK combination 
specified by the source application for the document (see page 1-13).

Image Smoothing
Automatic/Off/On

The On setting enhances the print quality of low-resolution images.

Toner Reduction
On/Off 

This option minimizes the amount of toner used on a printed job. For more 
information, see page 1-14.

Halftone Screen
Contone/Newsprint/Application Defined/
User Defined1-3

This option specifies how to simulate a halftone screen for your job. This 
option requires the Fiery Graphic Arts Package. For more information, see 
page 1-14.

Dithering
Auto/Text/Photo

This option specifies the best dithering method to use, based on what you are 
printing. Auto applies the best method automatically.

Auto Trapping
On/Off

This option specifies whether to use trapping. This option requires the Fiery 
Graphic Arts Package.

E-820 color print option What it does
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Rendering styles
The Rendering Style option specifies a CRD for color conversions. You can modify the 
Rendering Style option to control the appearance of images, such as prints from office 
applications or RGB photographs from Adobe Photoshop. The E-820 lets you select 
from the four rendering styles currently found in industry standard ICC profiles.

E-820 rendering style Best used for Equivalent ICC 
rendering style

Photographic—Typically results 
in less saturated output than 
presentation rendering when 
printing out-of-gamut colors. 
It preserves tonal relationships 
in images.

Photographs, including scans 
and images from stock 
photography CDs.

Image, Contrast, and 
Perceptual

Presentation—Creates 
saturated colors but does not 
match printed colors precisely 
to displayed colors. 
In-gamut colors such as flesh 
tones are rendered well; similar 
to the Photographic rendering 
style.

Artwork and graphs in 
presentations. In many cases, it 
can be used for mixed pages 
that contain both presentation 
graphics and photographs.

Saturation, Graphics

Relative Colorimetric—Provides 
white-point transformation 
between the source and 
destination white points. For 
example, the bluish gray of a 
monitor will map to neutral 
gray. You may prefer this style 
to avoid visible borders when 
not printing full-bleed. 

Advanced use when color 
matching is important, but you 
prefer white colors in the 
document to print as paper 
white. It may also be used with 
PostScript color management to 
affect CMYK data for 
simulation purposes.

Relative Colorimetric

Absolute Colorimetric—
Provides no white point 
transformation between the 
source and destination white 
points. For example, the bluish 
gray of a monitor will map to a 
bluish gray.

Situations when exact colors are 
needed and visible borders are 
not distracting. It may also be 
used with PostScript color 
management to affect CMYK 
data for simulation purposes.

Absolute Colorimetric



11-7 Managing color on the E-820
RGB Source Profile
The RGB source profile setting allows you to define the characteristics of the RGB 
data in your document so that the appropriate color conversion can occur on the 
E-820. Commonly used monitor color spaces are available from the driver and from 
the ColorWise Pro Tools Profile Manager. In addition, for special needs you can use 
ColorWise Pro Tools to download custom monitor or scanner profiles. 

When you specify a setting other than None for the RGB Source Profile, the E-820 
overrides source color space definitions or profiles that other color management 
systems may have specified. For example, if you specified a ColorSync System Profile 
on your Mac OS computer, the RGB Source Profile setting overrides it. In cases where 
you do not want this setting to override another specified source color space, choose 
the None setting. 

When you specify a setting other than None for the RGB Source Profile—since the 
color space definitions are overridden—the prints from the E-820 will be consistent 
across platforms. The E-820 RGB Source Profile options are:

• EFIRGB specifies an EFI-defined color space recommended for users who have no 
detailed information about their RGB data.

• sRGB (PC) specifies the industry standard definition for a generic Windows PC 
monitor.

• Apple Standard specifies the definition of all standard Mac OS computer monitors.

• Other allows you to specify custom RGB source settings. If you choose Other as the 
RGB Source setting, you can choose settings for the Gamma, Phosphors, and White 
Point options. 

• Sources 1-10 specify the definitions you download as RGB source profiles. For more 
information about downloading RGB source profiles, see page 3-4.

If you are printing with the PostScript driver from a Windows computer and have
two-way communication enabled, the name of each downloaded profile is 
represented in the RGB Source Profile setting pop-up menu. If you are printing with 
the AdobePS driver from a Mac OS computer, downloaded profiles appear as 
Source-1 through Source-10. For more information on two-way communication, 
see the User Software Installation Guide.
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• None instructs the E-820 to allow the RGB sources you defined elsewhere, such as in 
the application, to be used. When you set RGB Source to None, the appearance of 
colors will not be independent of the file type. For example, RGB EPS files will look 
different from RGB TIFF files. 

With RGB Source set to None, PostScript RGB data that contains a source color 
space definition is converted using the CRD specified by the Rendering Style option 
(see page 1-6). Non-PostScript RGB data and PostScript RGB data that does not 
contain a source color space definition are converted using a general undercolor 
removal (UCR) conversion method.

RGB Separation
The RGB Separation option determines how RGB colors (as well as Lab and XYZ 
colors) are converted to CMYK. The name of this option is meant to be descriptive, 
since the option defines the color spaces that will be used by the E-820 to “separate” 
the RGB data into CMYK values.

The two choices available for this option determine whether RGB data is converted 
into the full gamut of the copier (output) or is first converted into the gamut of 
another digital printer or press standard (simulation). This feature is helpful for 
making one device behave like another for RGB data. For example, if a high-quality 
ICC profile is available for another print device, the copier can simulate the behavior 
of that device.

RGB Separation is also useful for prepress applications. For example, it lets you 
experiment with the appearance of an RGB scan under different press printing 
conditions, without having to convert the RGB data to CMYK data for each 
condition. When the desired printing condition is found, you can then convert the 
file to CMYK, using the same CMYK simulation profile you used during the 
experimentation. 

NOTE: The RGB Separation print option should be used in conjunction with the 
Output Profile or CMYK Simulation Profile print options.

• Output converts all RGB colors into the CMYK color space of your copier (when set 
to the printer’s default), or a customized CMYK color space for your copier (when 
set to Output 1-10).
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• Simulation converts all RGB colors into the CMYK color space for a specified 
simulation (make sure to select the desired simulation with the CMYK Simulation 
Profile print option).

CMYK Simulation Profile
The CMYK Simulation Profile print option allows you to print press proofs or 
simulations. This setting specifies the offset press standard or other color printing 
device that you want to simulate. This option affects CMYK data only. 

With the Windows 9x/Me or Windows NT printer driver, you can also view an 
unlimited number of custom Full simulations created using ColorWise Pro Tools. 
On Windows 2000/XP and Mac OS computers, you can view up to 10 Full 
custom simulations. The number of custom simulations is limited by the disk space 
on the E-820.

If you are printing with the PostScript driver from a Windows computer and have
two-way communication enabled, the name of each downloaded or custom profile is 
represented in the CMYK Simulation Profile setting pop-up menu. If you are printing 
with the AdobePS driver from a Mac OS computer, downloaded or custom profiles 
appear as Simulation-1 through Simulation-10. For more information on two-way 
communication, see the User Software Installation Guide.

The None setting sends your original CMYK data to the copier in its calibrated state, 
without conversions to simulate another printer. This setting is not generally 
recommended, unless you want to bypass the conversion by ColorWise and use 
another color management system.

The CMYK Simulation Profile setting you specify depends on the press standard for 
which the CMYK data was separated. 

• For images that were separated using a custom separation (such as a separation 
produced with an ICC profile), choose the corresponding profile on the E-820 
with the CMYK Simulation Profile setting. 

• For images that were separated for SWOP, choose SWOP as the CMYK Simulation 
Profile setting. 
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NOTE: To properly simulate a printed image that was separated through the use of 
an ICC profile, the same profile must be present on the E-820. For more information 
about downloading ICC profiles to the E-820, see “Downloading profiles” on 
page 3-4.

The ColorWise Off settings send unconverted CMYK data directly to one of the two 
uncalibrated modes available on the copier. ColorWise Off-Gamma produces a density 
curve similar to that of an offset printer. ColorWise Off-Linear yields a straight line 
density curve. The ColorWise Off settings are designed for specific applications only. 
For example, Calibrator (one of the ColorWise Pro Tools) prints its patch pages using 
the Gamma mode. Avoid using uncalibrated modes for generic printing because other 
color settings and printing overrides may be incompatible.

CMYK Simulation Method
The CMYK Simulation Method lets you define your preferred CMYK-to-CMYK 
conversion technique.

• Quick applies one-dimensional transfer curves to adjust output densities in the cyan, 
magenta, yellow, and black channels. This technique leads to pleasant color output 
from your copier because pure primary colors are not “contaminated” by other 
colorants. While it is the fastest simulation method and perfect for drafts, avoid 
using it for final documents that will be used as press proofs. Other techniques offer 
more color simulation accuracy, which is expected by proofing applications. 

• Full (Source GCR) provides a complete and accurate simulation based on colorimetric 
transformations. Hues are preserved, even for primary colors. The Gray Component 
Replacement (GCR) level that was specified in the original (source) document is also 
preserved. Full (Source GCR) is therefore an excellent simulation technique for the 
highest quality press proofing applications.

• Full (Output GCR) is also a complete and accurate simulation method based on 
colorimetric transformations. Hues are preserved, even for primary colors. With this 
method, the Gray Component Replacement (GCR) level that was specified in the 
original document is not preserved. Instead, all CMYK data is reseparated using the 
GCR level specified by the Output Profile. This simulation technique is similar to 
traditional ICC color matching methods and is appropriate for most documents 
designed for the press, but reproduced on your copier.
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Output profile
The output profile is applied to all data in the print job, so make sure the selected 
profile is the right one for your job. The default output profile consists of both a profile 
for your copier, describing its color characteristics, and a calibration target that 
describes the expected behavior of the copier. 

In certain cases, you may want to customize the default output profile using the 
ColorWise Pro Tools Color Editor to achieve particular color effects (see page 3-10). 
If you do so, the new customized output profile is applied to all data in the print job. 
Changing the output profile only does not affect its associated calibration target 
(since the target is based on a copier model). You can edit D-Max values of the 
calibration target separately (see page 3-6).

You can use the ColorWise Pro Tools Profile Manager to download your own output 
profile to the E-820 (see page 3-4). Downloaded output profiles are at first associated 
with the calibration target that is tied to the default output profile. As mentioned 
above, you can edit calibration target D-Max values separately.

If you are printing with the PostScript driver from a Windows computer and have 
enabled two-way communication, the name of each downloaded or custom profile is 
represented in the Output Profile setting menu. If you are printing with the AdobePS 
driver from a Mac OS computer, downloaded or custom profiles appear as Output-1 
through Output-10. For more information on two-way communication, see the User 
Software Installation Guide.

Pure Black Text/Graphics
The Pure Black Text/Graphics option affects the printout for black text and vector 
graphics on a page. Under most circumstances, it is preferable to leave this option set 
to On. When Pure Black Text/Graphics is on, black colors generated by applications 
are printed using 100 percent black-only toner (for example, RGB = 0, 0, 0; 
CMYK = 0%, 0%, 0%, 100%; or K = 100%). This means the black text and line art 
will not exhibit halftone artifacts and will not be misregistered, since there is only one 
toner used. In addition, this setting eliminates blasting. This option is automatically 
set to On when the Black Overprint option is set to On.

For some jobs, it is preferable to clear this option, for example, if the page includes 
gradient fills that use black. The following table describes the behavior of the Pure 
Black Text/Graphics option with black data defined in different color spaces.
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NOTE: Use the Pure Black Text/Graphics option only when printing composites, not 
when printing separations. 

NOTE: PostScript applications, such as QuarkXPress, may convert elements defined as 
RGB = 0, 0, 0 to four-color CMYK black before sending the job to the E-820. These 
elements are not affected by the Pure Black Text/Graphics option. For details, see 
the application notes. Also, black text and line art defined as RGB = 0, 0, 0 in office 
applications (such as Microsoft Word) are converted to single-color black 
(CMYK = 0%, 0%, 0%, 100%) by the Microsoft PostScript Level 3 driver for 
Windows 2000/XP. To print this single-color black at the maximum toner density of 
the copier, set the Pure Black Text/Graphics option to On. 

Black Overprint
The Black Overprint option lets you specify whether or not black text—defined as 
RGB = 0, 0, 0, or as CMYK = 0%, 0%, 0%, 100%—overprints colored backgrounds. 

• On—Black text overprints colored backgrounds, eliminating white gaps and 
reducing halo effects or misregistration of colors. Setting Black Overprint to On 
automatically activates the Pure Black Text/Graphics option.

• Off—Black text knocks out colored backgrounds.

NOTE: PostScript applications may perform their own black overprint conversions 
before sending the print job to the E-820.

Input 
black color

Pure Black Text/Graphics

 On Off

RGB Prints 100% black With the default profile, prints a rich black using 
all toners.

CMYK Prints only with black toner, because CMYK 
simulations preserve the black channel. The actual 
amount of toner used depends on the current 
simulation and the calibration state of the copier.

Spot Prints only with black toner, because spot color 
simulations preserve the black channel. The actual 
amount of toner used depends on the current 
simulation and the calibration state of the copier.
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One example of how you might use this setting is with a page that contains black text 
on a light blue background. The background blue color is CMYK = 40%, 30%, 0%, 
0% and the black text is CMYK = 0%, 0%, 0%, 100%. 

• With Black Overprint On, the final text portions of the page are overprinted, or 
combined with the underlying colors. This results in CMYK = 40%, 30%, 0%, 
100% for the color used for the text. There is no transition in the cyan and magenta 
toners, and the quality of the output is improved since it will not show artifacts near 
the edges of the text. The option also works with text defined in the RGB color 
space, that is RGB = 0, 0, 0. 

• With Black Overprint Off, the border of the text is on an edge that has cyan and 
magenta toners on one side (outside the text) and black toner on the other side 
(inside the text). This transition may cause visible artifacts because of the practical 
limitations of the copier. 

NOTE: If you set Black Overprint Style to Text/Graphics, setting Black Overprint to On 
allows black text or graphics to overprint colored backgrounds (see page 1-4).

Spot Color Matching
The Spot Color Matching option provides automatic matching of spot colors with 
their best CMYK equivalents. 

• On—The E-820 uses a built-in table to generate the closest CMYK matches of spot 
colors your copier can produce. (New tables are generated when you add new output 
profiles.) If you have the Fiery Graphic Arts Package installed, the E-820 uses the 
CMYK matches determined through Spot On (see page 3-21).

NOTE: Spot colors not included in the built-in table are treated as CMYK.

• Off—The E-820 uses CMYK equivalents defined by the spot color manufacturer, 
such as PANTONE. These are the same CMYK equivalents used by applications 
that include spot color libraries.

For jobs that include spot colors, set Spot Color Matching to On unless you are 
printing press simulations. In that case, set Spot Color Matching to Off and choose the 
appropriate CMYK Simulation setting (see page 1-9).
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For PDF jobs that include spot colors and if spot colors are not included in the built-in 
table, setting Spot Color Matching to On retains the spot color originally specified. 
The E-820 makes reference to the built-in table to generate the closest CMYK matches 
of the original spot color.

NOTE: You can use the Spot Color Matching option only when printing composites, 
not when printing separations. 

Spot Color Matching and the PANTONE Coated Color Reference

The PANTONE Coated Color Reference (described in the Fiery Color Reference) 
prints differently depending on the Spot Color Matching setting. 

• On—The E-820 uses a built-in table or, if you have the Fiery Graphic Arts Package, 
the Spot On color dictionaries (see page 3-21) to generate the best matches of the 
PANTONE colors that your copier can produce. The PANTONE number is 
printed below each swatch. 

• Off—The E-820 prints swatches using the CMYK values recommended by Pantone, 
Inc. (and used by applications that provide PANTONE color libraries). The CMYK 
values used to generate the color, as well as the PANTONE number of the color, are 
printed below each swatch. These CMYK values are printed through the selected 
CMYK Simulation and Output Profile settings.

Toner Reduction
This option minimizes the total amount of toner and reduces effects of toner blasting, 
offset, or flaking. 

Halftone Screen
To correct problems with color quality when using a halftone screen, such as too much 
magenta in the printed image, make sure that the E-820 is calibrated for the particular 
halftone screen you use. This is important if you expect to compare a continuous tone 
page printed from a calibrated E-820 to a halftone printed page.

Changing halftone screens usually modifies the color response of a printer. With most 
printers that offer multiple (but standard) halftone screens, ColorWise Calibrator lets 
you select the halftone screen to calibrate. A measurement calibration set is maintained 
for each printer color response that is produced by different halftones coupled with 
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other parameters, such as media and resolution. The best color is achieved when a 
calibrated response and its corresponding output profile are specified by means of 
setting print options at print time.

However, when user-defined halftones are specified, the E-820 does not have adequate 
information about the resulting color response. This is why you must consider the 
halftone screen for separate calibration and profiling.

When your custom halftone changes the color response of your printer, you need a 
custom output profile. If you need to calibrate often for example, once a day), you 
need to perform the following custom profile creation procedure only once.

TO CALIBRATE THE E-820 FOR CUSTOM HALFTONE SCREENS

1. Determine the measurement instrument you use for calibration. 

2. On the Fiery Graphic Arts Package CD, open the CustomHalftonesCalibration folder.

This folder contains images of the calibration pages for various instruments and page 
sizes. If you print halftone screens only from Photoshop, open the Photoshop folder; 
otherwise, open the Other Applications folder. 

3. Locate the image file corresponding to the patch page for your instrument and paper 
size.

These images were prepared at the final sheet page size. In your software application, 
place them using no margins. Ignore warnings that the image may be clipped. Never 
“color manage” these files when you open or print them.

4. Open a blank document in the application you use for generating screened print jobs. 

5. Place the image of the calibration pages into the document.

This document is now the custom calibration page.

6. Print this custom calibration page, using your application-specific halftone settings 
and E-820 print option settings.

You must print with the CMYK Simulation Profile option set to Match Copy, which 
produces an uncalibrated patch page. 



11-16 E-820 Color Management
TIPS: Remember that you are printing CMYK patches in the raw state of the copier; 
most other E-820 print options are irrelevant and will be ignored. To increase the 
speed and reliability of the calibration, print your custom calibration page to a 
PostScript file with the appropriate E-820 print options. The next time you calibrate, 
download this PostScript file. Retaining this file in the E-820 Hold Queue makes the 
whole calibration process even faster. 

7. Open any output profile with ColorWise Calibrator.

For information about ColorWise Calibrator, see Chapter 2.

8. Resave the profile under a new name which describes of your custom halftone. 

9. Use ColorWise Profile Manager to associate this profile with the proper calibration set.

For information about ColorWise Profile Manager, see Chapter 3.

10. Use ColorWise Calibrator to perform the actual calibration. 

Do not use the Print button to generate the patch page. Instead, use the custom 
calibration screen page that you just printed.

TO PROFILE CUSTOM HALFTONE SCREENS FOR THE E-820

1. Calibrate your printer using the procedure on page 1-15. 

2. Using ColorWise Profile Editor, open the output profile saved in step 9 on page 1-16.

3. Change the Target Dmax Values to match the actually measured Dmax values. 

4. Save this modified output profile under the same name. 

5. Using EFI Color Profiler, print the calibration patches using the same halftone screens 
you have just calibrated.

6. Use ColorWise Profile Manager to set the profile saved in step 4 of the current 
procedure as the system default profile. 

This is necessary because downloaded profiles take their calibration targets from the 
system default profile. 

7. Download to the “Output Profiles” area the profile(s) you just created.
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PostScript printer driver for Windows and Mac OS
You can access the printer driver options described in this section by choosing 
Start> Settings> Printers, right-clicking the appropriate PPD name, and choosing 
Properties (Windows 9x/Me), Document Defaults (Windows NT), or Printing 
Preferences (Windows 2000/XP) from the pop-up menu. To access the Mac OS driver 
options, choose Print from the File menu of your application. These settings are also 
accessible from the Print Setup or Page Setup dialog boxes of most applications. 

For Windows computers, the E-820 driver interface enables you to save combinations 
of settings that you can later access. Additionally, you can choose different settings for 
individual jobs from the applications you use.

The printer driver writes a PostScript file containing the instructions generated by your 
application and the E-820 print options you chose. The printer driver sends the 
PostScript file to the E-820. The E-820 then performs PostScript processing and color 
conversions and sends raster color data to the print device.

NOTE: The following illustrations and instructions do not apply to all applications. 
Many applications, such as Adobe PageMaker, Adobe Photoshop, Adobe Illustrator, 
QuarkXPress, and CorelDRAW, have other color management options in addition to 
those presented in the printer driver. For information on specific applications, see the 
Fiery Color Reference.

Setting color management print options for Windows 9x/Me and 
Windows NT
This section explains how to set E-820 color print options with the Adobe PostScript 
Printer Driver for Windows. This driver is a PostScript 3 printer driver that takes full 
advantage of the color features of the E-820. Before you proceed, make sure you have 
completed the following procedures:

• Install the Adobe PostScript Printer Driver and the E-820 PPD (see the User 
Software Installation Guide).

• Set up the E-820 for printing (see the Configuration Guide).

• Install the ICC output profile for the E-820 on your Windows computer (see 
page 3-4).
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TO SET PRINT OPTIONS FOR WINDOWS 9X/ME/NT

1. Access the printer driver options, as described on page 1-17. 

2. Click the Fiery Printing tab, and choose settings from the ColorWise menu for the 
print options described on page 1-3.

3. Click Expert Settings.

The Expert Color Settings flowchart appears. This window displays additional color 
settings for the E-820. Each option includes a menu from which you can select settings 
for your specific job.

4. Click Update to display the current E-820 settings. 

If Update does not appear, make sure that two-way communication is set up as 
described in the User Software Installation Guide.

5. To specify custom RGB source settings, choose Other for the RGB Source Profile, and 
then click Custom Setup.

Choose ColorWise 

Click Expert Settings to access
additional ColorWise options
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The following dialog box allows you to specify custom RGB source settings 
(see page 1-7). 

For most users, the default settings provide the right level of color control. For more 
information about individual print options, see page 1-3.

Adobe PostScript printer driver for Mac OS
This section explains how to set color management print options with the AdobePS 
printer driver for Mac OS, a PostScript 3 driver that takes full advantage of the color 
features of the E-820 and lets you save a set of print option settings.

Before you continue, make sure you have completed the following procedures, as 
described in the User Software Installation Guide:

• Install the AdobePS printer driver and the E-820 PPD.

• Select the E-820 in the Chooser and set it up with the E-820 PPD.

• Install the ICC output profile for the E-820 on your Mac OS computer 
(see page 3-4).

NOTE: The following illustrations and instructions do not apply to all applications. 
Many applications, such as PageMaker, Photoshop, Illustrator, QuarkXPress, and 
CorelDRAW, have other color management options in addition to those presented 
in the printer driver. For information on specific applications, see the Fiery Color 
Reference.
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Setting color management print options

You can choose print options from the various panes of the AdobePS driver dialog box. 
To access the initial AdobePS dialog box, choose Print from the File menu of your 
application.

NOTE: The word “pane” is used to describe the different pages that appear in the driver 
dialog box when you make selections from the menu at the upper left corner of the 
dialog box. Each pane presents a particular set of print options.

The AdobePS driver includes the following Color Matching options.

• Color/Grayscale—When this setting is used to print to the E-820, ColorWise 
provides all color conversions on the E-820. Typically, you should use this option 
when printing to the E-820.

• PostScript Color Matching—Can be used with PostScript devices such as the E-820. 
It provides for color conversion using a color rendering dictionary (CRD) that is 
downloaded with the print job. This method requires that the file is saved as an EPS 
with PostScript Color Management selected.

NOTE:If you use the PostScript Color Matching option, the driver may, depending 
on the application in use, attach a CMYK source definition to the CMYK data in 
your document. In such a case, the CMYK data in the document is reseparated 
using a E-820 CRD. The destination color space for the CRD is determined by the 
RGB Separation print option. When RGB Separation is set to Simulation, CMYK 
data is printed according to all specified CMYK Simulation Profile and CMYK 
Simulation Method settings. When RGB Separation is set to Output, CMYK data is 
converted to the selected output profile’s CMYK color space.

• ColorSync Color Matching—Provides for color conversion on the host computer. 
This option can be used with PostScript devices such as the E-820, but it is intended 
for use with PostScript Level 1 devices. If you use this option, be sure to specify 
the E-820 ICC profile as the Printer Profile. ColorSync Color Matching is not a 
suggested color matching method because it does not work in conjunction with all 
applications and requires that you disable features of ColorWise on the E-820.



11-21 PostScript printer driver for Windows and Mac OS
TO SET E-820 COLOR MANAGEMENT OPTIONS

1. In the AdobePS Print dialog box, choose Color Matching from the General menu.

2. Choose Color/Grayscale from the Print Color menu.

Choose Color Matching 
from this menu

Choose Color/Grayscale
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3. In the Printer Specific Options menus, choose settings for the print options described 
on page 1-3. 

4. If these settings are used regularly, click Save Settings to save them for subsequent 
jobs.



22-1 An overview of calibration
Calibrating the E-820 ensures consistent, reliable color output. You can calibrate 
the E-820 using ColorWise Pro Tools in combination with any of the following color 
measurement instruments, available as separately purchased options:

• X-Rite DTP41 automatic scanning spectrophotometer

• X-Rite DTP32 automatic scanning densitometer

• EFI Densitometer ED-100 hand-held densitometer 

By connecting the instrument to the serial port on your computer, you can quickly 
measure calibration color patches and download measurements to the E-820. 
For information on setting up and operating the DTP41 and DTP32, see Appendix A.

You can also obtain measurements from the copier’s built-in scanner and calibrate 
using AutoCal™ or ColorCal™, which do not require the use of a measurement 
instrument and can be run from ColorWise Pro Tools or the E-820 Control Panel.

This chapter explains how calibration works and provides instructions for all 
calibration procedures.

For information on advanced calibration and simulation features available with 
ColorWise Pro Tools, such as editing profiles and creating custom profiles, see 
Chapter 3. A format for inputting color measurements from other densitometers 
is described in Appendix B.

NOTE: The procedures described in this chapter are fundamentally the same for 
Windows and Mac OS computers. The main differences are the interface cable and the 
port used to connect to the measurement instrument. This chapter shows illustrations 
for the Windows version. 

NOTE: The term computer is used to refer to any computer running ColorWise Pro 
Tools.

Chapter 2:
Color Calibration
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An overview of calibration
Calibration generates curves that adjust for the difference between the actual toner 
densities (measurements) and the response expected by the output profile.

• Measurements represent the actual color behavior of the copier.

• Calibration sets are sets of measurements.

• A calibration target that describes the expected behavior of the copier is contained 
in each output profile.

Once you have calibrated the E-820, a calibration set is stored. This calibration set will 
be used when it is associated with an output profile. Every output profile has an 
associated calibration set. If you have not specified one, the calibration set associated 
with the default output profile is used.

If you change the calibration after a saved job has been processed (RIPped), you do not 
need to reprocess (reRIP) the job. The new calibration affects the job without needing 
to be reprocessed.

NOTE: Changing calibration has the potential to affect all jobs for all users, so you 
may want to limit the number of people authorized to perform calibration. You can set 
an Administrator password in E-820 Setup to control access to calibration (see the 
Configuration Guide).

Understanding calibration
Although most users’ needs are met by the default calibration set, the E-820 allows you 
to choose a calibration set to customize calibration for specialized jobs. 

Calibration allows you to:

• Maximize the color reproduction capabilities of the E-820.

• Ensure consistent color quality over time.

• Produce consistent output across E-820 servers.

• Achieve better color matches when reproducing spot colors such as PANTONE 
colors or other named color systems.

• Optimize the E-820 for using ColorWise rendering styles (CRDs) and CMYK 
simulations, and for using ICC profiles.
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How calibration works
Success in obtaining satisfactory print quality from the E-820 depends on many 
factors. Among the most important are establishing and maintaining optimal toner 
densities. The density is the measure of the light absorbed by a surface. By carefully 
regulating toner densities, you can obtain consistent printed color.

Even with a calibrated system, toner density is affected by service settings, humidity, 
and temperature; density also tends to drift over time. Regular measurement detects 
day-to-day variations in densities, and calibration corrects for them.

Calibration works by creating calibration curves on the E-820 that compensate for the 
difference between actual (measured) and desired (target) density values. These 
calibration curves are the graphic equivalent of transfer functions, which are 
mathematical descriptions of changes that will be made to the data you start with. 
Transfer functions are often graphed as input or output curves.

The E-820 generates calibration curves after comparing measured values to the final 
target values for each of the four toner colors. The target values are based on the output 
profile specified.

Measurements

Measurement files contain numerical values that correspond to the toner density 
produced by the copier when it prints solid cyan, magenta, yellow, and black, and 
graduated tints of those colors.

To create a measurement file, first print a page of color patches. Then measure the 
patches using either a color measurement instrument connected to a computer on the 
network or, if it is available, the print device’s scanner. The new measurements are 
automatically downloaded to the E-820.
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Output profiles and calibration sets

Output profiles and calibration sets define desired calibration results. The E-820 
provides one (or more) output profiles and one (or more) calibration sets. When you 
calibrate the E-820, you can select the calibration set that corresponds to the typical 
printing jobs at your site. This same calibration set can be associated with one or more 
output profiles. (For more information on output profiles, see page 1-11.)

Scheduling calibration
In general, you should calibrate the E-820 at least once a day, depending on the 
volume of print jobs. If it is very important to maintain consistent color, or if the 
copier is subject to wide fluctuations in temperature or humidity, calibrate every few 
hours. For the best performance, calibrate whenever there is a noticeable change in 
print quality.

If you need to split a print job into two or more batches to be printed at different 
times, it is especially important to calibrate before printing each batch. You should 
also calibrate the E-820 after copier maintenance. However, because the copier may be 
less stable immediately after maintenance, wait until you have printed approximately 
50 pages before you calibrate. 

NOTE: Since printed output from the copier is very sensitive to changes in temperature 
and humidity, the copier should not be installed near a window or in direct sunlight, or 
near a heater or air conditioner. Paper is sensitive to climate changes, as well. It should 
be stored in a cool, dry, stable environment, and reams should remain sealed until they 
are needed.

To monitor print quality, print color reference pages. You can print Color Charts from 
the Control Panel (see the Configuration Guide) or Command WorkStation (see the Job 
Management Guide), and the color reference pages included with the user software (see 
the User Software Installation Guide ). All of these pages include fully saturated color 
patches and pale tints of cyan, magenta, yellow, and black. Images with skin tones offer 
a very good basis for comparison. You can save and compare pages you printed at 
different times. If there is a noticeable change in appearance, calibrate the E-820.
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When you examine the Test Page, keep in mind that all color patches should be visible, 
even though they may be very faint in the five percent and two percent range. Each 
color’s patch set should show uniform gradation from patch to patch as the color 
lightens from 100 percent to zero percent.

If the solid density patches (100% cyan, magenta, yellow, or black) look less saturated 
with time, show the pages to your copier service technician to find out whether 
adjusting the copier can improve output.

Checking calibration status
You can check whether the E-820 is calibrated, which calibration set and output profile 
were used, and when the copier was last calibrated by doing the following:

• Print a Configuration page or Test Page from the Control Panel or 
Command WorkStation.

• Select a calibration set in Calibrator—the last calibration and the user who 
performed it are displayed.

Using Calibrator
ColorWise Pro Tools Calibrator lets you calibrate the E-820 using the measurement 
method of your choice.

Changing the calibration has the potential to affect all jobs for all users, so you may 
want to limit the number of people authorized to perform calibration. You can set an 
Administrator password to control access to calibration (see the Configuration Guide).

NOTE: Multiple users can be connected to one E-820 with ColorWise Pro Tools, but 
only one user at a time can use Calibrator. An error message appears if you try to 
calibrate when another user is already using ColorWise Pro Tools to calibrate.
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Starting Calibrator
Start Calibrator from the ColorWise Pro Tools main window.

TO CALIBRATE THE E-820 USING CALIBRATOR

1. Start ColorWise Pro Tools and connect to the E-820.

For instructions on configuring the connection to the E-820, see the User Software 
Installation Guide.

NOTE: If the connection to the E-820 from Command WorkStation (which also allows 
for access to ColorWise Pro Tools) is not established, you can start ColorWise Pro 
Tools independently of Command WorkStation.

2. Click Calibrator.
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The Calibrator window appears.

You can use the Calibrator window to perform the calibration method of your choice. 
Procedures for each calibration method are described in sections later in this chapter.

Calibration methods 
appear here
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Expert Mode
You can set the Calibrator to either Standard or Expert Mode. You can perform all 
essential calibration tasks while in Standard Mode. Expert Mode offers two additional 
options: Print Pages and View Measurements.

With the Print Pages option, you can print a calibration Comparison Page showing the 
results of the new measurements with any profile associated with the currently selected 
calibration set. You can also create a custom comparison page and save it as a 
PostScript or Encapsulated PostScript (EPS) file called CALIB.PS. You can then print 
the file to the Hold Queue of the E-820 from your application or download it to the 
Hold Queue with Fiery Downloader. An additional way to create the CALIB.PS file is 
to rename any job in the Hold Queue using Command WorkStation (see the Job 
Management Guide).

Calibration methods 
appear here
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With the View Measurements option, you can view the current set of measurements as 
a table or graph that shows both the measurements and the target curves.

When more than one profile uses the same target, an additional menu called Plot 
Against appears in the upper-right corner of the dialog box. It lists all output profiles 
that use that same calibration set. Selecting an output profile from this menu displays 
the target curves associated with that profile. If each output profile contains a unique 
calibration target, when you switch profiles, the curves displayed also change.

Output profile name
appears here
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Restoring default calibration measurements
Use the following procedure to return to default preset calibration measurements.

TO RESTORE DEFAULT CALIBRATION MEASUREMENTS

1. In the main Calibrator window, click Restore Device.

2. Click OK to restore the preset default calibration set.

NOTE: Restore Device applies only to the currently selected calibration set.

Calibrating the E-820 with the DTP41
Using the ColorWise Pro Tools Calibrator application and the DTP41 
spectrophotometer, you can quickly measure color patches generated by the copier 
and automatically download these measurements to the E-820.

NOTE: Before using ColorWise Pro Tools and the DTP41 to calibrate the E-820, follow 
the instructions on page A-4 for calibrating the DTP41 spectrophotometer.

TO CALIBRATE THE E-820 USING THE DTP41

1. Start Calibrator.

For instructions on starting Calibrator, see page 2-6.

2. Choose X-Rite DTP41 as the measurement method.

3. In the Check Print Settings pane, choose the desired calibration set.

Choose the appropriate calibration set for the type of media you use most often. 

NOTE: For this calibration to take effect, the calibration set must be associated with one 
or more output profiles. There is no need to make any new associations for the default 
calibration set, since it is already associated with the default output profile.
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4. In the Generate Measurement Page pane, click Print.

5. Choose the appropriate options, and click Print.

In the Page Type menu, choose either 21 or 34 Sorted Patches. 

In the Paper Size menu, the menu will automatically choose LTR/A4 for 21 Sorted 
Patches or 11x17/A3 for 34 Sorted Patches. For your copier model, 21 Sorted Patches 
is recommended.

In the Input Tray menu, choose the paper source for printing the measurement page.

6. Retrieve the measurement page from the copier.

7. In the Get Measurements pane, click Measure. 

The Measurement Options dialog box appears, displaying the specified Page Type and 
Paper Size options. 
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8. Click Measure.

The Start dialog box appears.

9. If necessary, choose the appropriate COM port for the DTP41 from the Available Ports 
menu. Click Start Measurements.

The Measurements dialog box appears.
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10. Feed the measurement page into the DTP41, starting with the cyan strip. 

Align the page in the measurement page slot of the DTP41 so the appropriate color 
column is centered below the alignment mark (see the diagram on page A-2). Insert 
the page about 3 inches, past the front idler rollers, until it rests against the rear 
drive rollers. 

11. Click Read Strip.

The DTP41 pulls the measurement page through automatically.

Once the measurement page is read, Calibrator instructs you to insert and align the 
page again for the next color. 

12. Repeat the measurement process for the magenta, yellow, and black strips.

A check mark appears on the circle of the color just read, and the Status field indicates 
that color was measured successfully.

You can use the Previous and Next buttons to reverse or advance to another step in the 
measurement sequence.

13. When the Status field indicates that all four color strips have been read successfully, 
click Accept Measurements.
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14. In the Measure dialog box, click OK.

15. Click Apply in the Calibrator window to implement the new calibration set.

16. Click OK in the Information dialog box.

This completes the E-820 calibration process.

Calibrating the E-820 with the DTP32
Using the DTP32, you can quickly measure color patches and download these 
measurements to the E-820 using ColorWise Pro Tools Calibrator.

TO CALIBRATE THE E-820 USING THE DTP32

1. Start Calibrator.

For instructions on starting Calibrator, see page 2-6.

2. In the Select Measurement Method pane, choose X-Rite DTP32.

3. In the Check Print Settings pane, choose the desired calibration set.

If more than one option appears, choose the appropriate calibration set for the type of 
media you will use most often. 

NOTE: For this calibration to take effect, the calibration set must be associated with one 
or more output profiles. The default calibration set is already associated with the 
default output profile, so there is no need to make any new associations.

4. In the Generate Measurement Page pane, click Print.

The Print Options dialog box appears.

5. Choose the appropriate options, and click Print.

For Page Type, choose either 34 or 21 Sorted Patches.

In the Paper Size menu, the menu will automatically choose LTR/A4 for 21 Sorted 
Patches or 11x17/A3 for 34 Sorted Patches. For your copier model, 21 Sorted Patches 
is recommended.
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For Input Tray, specify the paper source.

6. Retrieve the measurement page from the copier.

7. Click Measure in the Get Measurements pane. 

The Measurement Options dialog box appears, displaying the specified Page Type and 
Paper Size options.

8. Click Measure.

In the dialog box that appears, follow the directions for feeding the measurement 
page through the X-Rite DTP32.

The Status field displays instructions for selecting the port and feeding the 
measurement page through the DTP32 four times, once for each color strip.

9. When the Status field indicates that the measurements were read successfully, 
click Accept. 
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10. Click OK in the Measure dialog box.

11. Click Apply in the Calibrator window to implement the new calibration set.

12. Click OK in the Information dialog box.

This completes the calibration process.

Using the EFI Densitometer ED-100
The EFI Densitometer ED-100 is a hand-held instrument that measures the density of 
printed ink and toner. Like the DTP32, the ED-100 is a reflection densitometer that 
you can use to calibrate the E-820.

The ED-100 is available as a separately purchased option.

Setting up the ED-100
To use the ED-100 for calibration purposes, you must first set it up for use with your 
computer. For complete instructions on setting up the ED-100, see the documentation 
that is included with the instrument.

The following illustration shows the different components of the ED-100.

Indicator light

Sample aperture
(underneath)

Measure button
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Calibrating the E-820 with the ED-100
You can use ColorWise Pro Tools in conjunction with the ED-100 to calibrate 
the E-820.

TO CALIBRATE THE E-820 USING THE ED-100

1. Start Calibrator.

For instructions on starting Calibrator, see page 2-6.

2. Choose EFI Densitometer ED-100 as the measurement method.

3. In the Check Print Settings pane, choose the desired calibration set.

Choose the appropriate calibration set for the type of media you will use most often. 

NOTE: For this calibration to take effect, the calibration set must be associated with one 
or more output profiles. There is no need to make any new associations for the default 
calibration set, since it is already associated with the default output profile.

4. In the Generate Measurement Page pane, click Print.

5. Choose the appropriate options and click Print.

In the Page Type menu, choose either 34 or 21 Sorted Patches, or 34 or 21 
Randomized Patches. Sorted patches are printed on the page in order of their hue and 
saturation levels. Randomized patches are printed on the page in random order, to help 
compensate for density inconsistencies on different areas of the page.

In the Paper Size menu, the menu will automatically select LTR/A4 for 21 Patches or 
11x17/A3 for 34 Patches.
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In the Input Tray menu, specify the paper source for printing the measurement page.

6. Retrieve the measurement page from the copier.

7. Click Measure in the Get Measurements pane.

8. Choose the appropriate options, and then click Start.

The Page Type menu automatically chooses the measurement page type that you 
printed in step 6.

Use the arrow buttons next to the Clicks Per Patch field to choose the number of 
measurements you want to take for each patch on the page. When you choose multiple 
clicks, the average value of all measurements taken for the patch is returned to the 
E-820. Multiple measurements are more accurate, but may take more time.

Select the Audio Feedback option if you want to hear a confirmation tone each time a 
measurement is recorded. A single tone indicates a successful measurement; two tones 
indicate a measurement error. If you have specified multiple clicks per patch, the tone 
sounds after you take the final measurement.

If necessary, choose the appropriate COM port for the ED-100 from the Port menu.
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When you click Start, the Measurements window appears. Directions for measuring 
the patches appear in the Status area.

9. Place the ED-100 over the specified patch on the Measurement Page, making sure to 
center the sample aperture over the patch. Press Measure to take the measurement.

NOTE: For a more accurate measurement, place several plain sheets of paper beneath 
the Measurement Page to block underlying colors from being read by the instrument.

If you have specified multiple clicks per patch, continue pressing Measure to take the 
required number of measurements. We recommend that you move the ED-100 
slightly after each measurement while keeping it within the patch circle.
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When the patch has been measured successfully, a checkmark appears in the patch 
preview in the Measurements window. The window identifies and highlights the next 
patch to be measured.

10. Repeat step 9 to measure each successive patch on the Measurement Page.

To retake a measurement, select the desired patch preview in the Measurements 
window, and then measure the patch on the page using the ED-100.

NOTE: You must take the measurements in the order outlined in the Measurements 
window and on the measurement page.

11. When all the patches have been read successfully, click Accept.

12. Click Apply in the Calibrator window to implement the new calibration set.

13. Click OK in the Information dialog box.

This completes the E-820 calibration process.
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Using AutoCal and ColorCal
AutoCal and ColorCal are methods to calibrate the E-820 without the use of an 
additional spectrophotometer or densitometer. Instead, these methods use the copier’s 
built-in scanner to measure toner density values. Because using either AutoCal or 
ColorCal provides an equally accurate calibration of the E-820, you need to perform 
only one of these methods.

You can perform either AutoCal or ColorCal calibration from ColorWise Pro Tools or 
the E-820 Control Panel. For troubleshooting during the AutoCal procedure, see the 
Job Management Guide.

NOTE: To calibrate using AutoCal or ColorCal, you will need the Kodak Gray Scale 
strip included in the customer media pack that came with your E-820. You also need 
the Kodak Gray Scale strip to calibrate the scanner of the copier for ColorCal.

Calibrating with ColorWise Pro Tools and AutoCal or ColorCal
When you run ColorCal from ColorWise Pro Tools, you have the option to calibrate 
the copier’s scanner before calibrating the E-820 itself. This option is not available for 
AutoCal. It is recommended to calibrate the scanner for ColorCal when the copier 
output has been adjusted, such as after maintenance or service.

TO CALIBRATE WITH COLORWISE PRO TOOLS AND AUTOCAL OR COLORCAL

1. Start Calibrator.

For instructions on starting Calibrator, see page 2-6.

2. In the Select Measurement Method pane, choose AutoCal or ColorCal.

3. In the Check Print Settings pane, choose the desired calibration set.

If more than one option appears, choose the appropriate calibration set for the type of 
media you will use most often. For more information about calibration sets, see 
page 2-2 and page 3-9.

NOTE: For this calibration to take effect, the calibration set must be associated with one 
or more output profiles. The default calibration set is already associated with the 
default output profile, so there is no need to make any new associations.
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4. Click Print in the Generate Measurement Page pane.

5. Choose the Input Tray to use for the measurement page and click Print.

The Page Type is automatically set to AutoCal Page or ColorCal Measurement Page. 
The Paper Size is automatically set to LTR/A4.

6. Retrieve the Measurement Page from the copier.

7. Click Measure in the Get Measurements pane. 

If you chose the AutoCal method, skip to step 11.

If you chose the ColorCal method, an alert message appears, asking if you want to 
calibrate the copier’s scanner. 

8. If you are using ColorCal and want to calibrate the scanner, click Yes.

9. Choose the Input Tray to use for the scanner measurement page and click Print. 
Retrieve the scanner measurement page from the copier.

AutoCal ColorCal
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10. Place the Gray Scale strip, Color Scale strip, and scanner measurement page in the 
correct positions on the copier glass for scanner calibration.

Place the Gray Scale face down on the copier glass so that it will be centered along the 
top edge of the scanner measurement page. Then place the Color Scale strip face down 
on the copier glass so it is centered below the Gray Scale strip, keeping a distance of 
0.25 inch to 0.5 inch between the two strips. Finally, place the scanner measurement 
page face down over the strips. 

To perform the scanner calibration, click Continue in the dialog box that appears.

After the scanner has been calibrated, another dialog box appears, prompting you to 
calibrate the E-820.

11. Follow the directions in the dialog box for placing the Gray Scale strip and the AutoCal 
or ColorCal measurement page on the copier glass. Click Continue.

12. Click Apply in the main Calibrator window to implement the new calibration set.

13. Click OK in the Information dialog box.

This completes the calibration process.

AutoCal ColorCal
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Calibrating from the Control Panel with Fiery AutoCal or ColorCal
If an Administrator password has been set, you will need it to perform calibration 
from the Control Panel. For instructions on using the E-820 Control Panel, see the 
Configuration Guide. 

It is also possible to remove calibration measurements from the E-820. In general, it is 
not necessary, because any new calibration replaces the existing one if the same 
calibration set is selected. 

TO USE FIERY AUTOCAL OR COLORCAL FROM THE CONTROL PANEL

1. At the Idle screen, press Menu to enter the Functions menu. 

2. Using the Up and Down arrow buttons and the Line Selection buttons, choose 
Calibration, and then choose Set Up Calibration.

If a password is set on the E-820, enter it and press OK.

3. For Calibration Mode, choose Standard or Expert.

Expert Mode adds the option to print a Comparison Page (see page 2-8).

4. For Tray, choose the paper source for the patch page and press OK.

Choose LTR/A4 from the E-820 Control Panel.

NOTE: If you print a measurement page from the Manual Feed tray, you must load the 
appropriate paper in the tray and select the correct paper size from the copier touch 
panel display.

5. Choose Calibrate.

6. Select the Calibration Set.

You can choose from the list of all calibration sets on the E-820. This screen appears 
only if more than one calibration set is available. For more information about 
calibration sets, see page 2-2 and page 3-9.

7. When prompted, choose Yes to print the measurement page.

This page is comprised of swatches of color that will be measured by the copier’s 
scanner and then compared to the target color values. After the page is printed, the 
Measure Page screen appears.
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8. Choose Yes in the Measure Page screen.

9. When prompted on the Control Panel, place the Kodak Gray Scale strip face-down on 
the copier glass.

Place the strip along the top edge of the copier so that it is centered between the paper 
width marks on the copier.

10. Place the color measurement page face-down over the grayscale strip. 

Make sure the patches on the grayscale strip do not overlap the color patches.

Close the platen glass cover, being careful not to move the grayscale strip and color 
measurement page.

11. On the Control Panel, choose OK.

Status messages display the progress of scanning and calculating measurements.

12. When prompted to Print Comparison Page (Expert Mode only), choose Yes to print a 
preview of the selected calibration.

Choose from a list of output profiles that use the same calibration set and press OK. 
This option appears only in Expert Mode calibration.

13. When prompted to apply or overwrite the calibration, choose Yes.

14. Choose Yes to confirm.

Status messages display progress information. When calibration is complete, the 
Control Panel display returns to the Functions menu.

Place color measurement page face
down over grayscale strip

Place grayscale strip face down
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TO REMOVE CALIBRATION FROM THE CONTROL PANEL

1. From the E-820 Control Panel, access the Calibration menu as described on page 2-24.

2. Choose Remove Calibration.

3. When prompted, verify that you want to proceed with removing calibration.

The current measurements are removed and a default calibration is restored.
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Designed to give you flexible control of color printing, ColorWise Pro Tools include 
the following color management tools:

• Calibrator (see Chapter 2)

• Color Editor

• Profile Manager

• Spot On (available only if you have installed the Fiery Graphic Arts Package)

• Color Setup

ColorWise Pro Tools for Windows and Mac OS computers are fundamentally the 
same; differences are noted in this chapter. The windows and dialog boxes illustrated 
are the Windows versions. For information on installing and configuring a connection 
to ColorWise Pro Tools, see the User Software Installation Guide.

NOTE: If the connection to the E-820 from Command WorkStation (which also allows 
for access to ColorWise Pro Tools) is not established, you can start ColorWise Pro 
Tools independently of Command WorkStation.

Profile Manager
Profile Manager allows you to manage and edit ICC profiles. In the case of the E-820, 
these profiles are divided into RGB Source, Simulation, and Output profiles.

• RGB Source contains all monitor profiles resident on the E-820. RGB Source profiles 
are used to define the source color space for RGB colors processed by the E-820.

Chapter 3:
ColorWise 
Pro Tools
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NOTE:If you use Photoshop 5.x or 6.x, you can upload the profile for your selected 
working space to the E-820 and choose that as your RGB Source profile. For more 
information, see the Fiery Color Reference. 

• Simulation contains printer profiles used to simulate another device on the E-820.

• Output contains copier profiles that describe the copier. For more information on 
output profiles, see page 1-11.

NOTE: Changing the E-820 default profiles affects all  jobs for all  users. You may want 
to limit the number of people authorized to use ColorWise Pro Tools by setting an 
Administrator password.

The following profiles are provided with the E-820. 

RGB Source:

• sRGB (PC)—source color space for a generic Windows computer monitor

• Apple Standard—standard source color space for Mac OS computer monitors with 
older versions of ColorSync

• EFIRGB—preset default setting for a E-820

Simulation:

• SWOP-Coated—United States press standard

• Euroscale—European press standard

• DIC—Japanese press standard

In addition, one or more output profiles are provided with the E-820. 

For more information on output profiles, see page 1-11.
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Setting the default profiles
The default profiles are applied to all print jobs sent to the E-820, unless you override 
them using print options. Therefore, the defaults should be the most commonly used 
profiles.

TO SPECIFY A DEFAULT PROFILE

1. Start ColorWise Pro Tools and click Profile Manager.

The left side of the main Profile Manager window lists the ICC profiles in the default 
directory of your computer; the right side lists the three profiles on the E-820.

The Lock icon ( ) to the left of a profile name indicates that the profile cannot be 
deleted and can be edited only if saved under a new name. Only Simulation and 
Output profiles can be edited. 

A small icon to the left of a profile name indicates the default profile for each category 
(RGB Source, Simulation, and Output). If you designate a different profile as the 
default, the icon appears next to your designated profile. The icon indicating the 
default RGB Source and Output profiles looks like a target ( ). The icon indicating 
the default Simulation profile changes in appearance depending on whether the default 
RGB Separation setting is set to Simulation ( ) or Output ( ).

2. Select the profile you want as the default for a profile type and click Profile Settings.

Output profiles
appear here
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3. In the Profile Settings dialog box, click Default and click Apply.

4. Click OK.

In the main Profile Manager window, the target icon appears next to the new default 
profile you specified. 

5. Repeat steps 2 through 4 for each type of profile.

If no default is set for RGB Source, the RGB Source print option is set to None. If no 
default profile is set for Simulation, the CMYK Simulation print option is set to None. 
For more information on print options, see Chapter 1.

The Output profile always has a default profile. You can change the Output default by 
selecting a preset profile you want as the default and clicking Profile Settings. Or create 
a new default under a new name by selecting a preset profile and specifying your choice 
of the calibration set in the Use Calibration Set menu and a new name in the Profile 
Description menu.

Downloading profiles
The E-820 comes with default profiles. You can download additional profiles from any 
computer connected to the E-820.

TO DOWNLOAD A PROFILE

1. Start ColorWise Pro Tools and click the Profile Manager.

The left side of the main Profile Manager windows lists the ICC profiles in the default 
directory of your workstation.

• Windows 9x/Me—Windows\System\Color

• Windows NT 4.0—Winnt\System32\Color

• Windows 2000—Winnt\System32\Spool\Drivers\Color

• Windows XP—Windows\System32\Spool\Drivers\Color

• Mac OS—System Folder:Preferences:ColorSync Profiles for ColorSync 2.0, and 
System Folder:ColorSync Profiles for ColorSync 2.5 or later

2. If the desired profile does not appear, click Browse to go to a different directory. 
Browse to the directory containing the profile you want to download and click OK.
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3. When the profile you want to download appears in the list in the main Profile Manager 
window, select it.

If the profile is compatible with the E-820, a green arrow indicates that the profile is 
available for downloading. Only output device profiles are downloadable to Simulation 
and Output. Only input device profiles are downloadable to RGB Source.

NOTE: On Windows computers, the profiles must have an extension of .icc or .icm to 
be listed. On Mac OS computers, the profiles must have a file type of “profile.”

All ICC profiles in the selected directory on your computer are displayed in the list in 
the main Profile Manager window. However, because a profile is listed does not 
necessarily mean it can be downloaded to the E-820. 

Simulation profiles should be profiles only for those devices you want the E-820 to 
match in terms of color output characteristics. Output profiles should be profiles only 
for the copier to which you print. Although CMYK printer profiles can be downloaded 
as Simulation or Output, consider how they will be used. If you want the E-820 prints 
to look like another printer, download that profile as a Simulation. If you have a 
custom profile of the copier you print to, download that profile as an Output profile.

4. Click the arrow to download the profile and click OK when the download is complete.

The new profile now appears in the list of profiles on the right side of the Profile 
Manager main window.

For Windows 2000/XP and Mac OS computers, this profile must be associated with 
one of the predefined names (Source-1 through Source-10 for RGB Source, 
Simulation-1 through Simulation-10 for Simulation, or Output-1 through Output-10 
for Output) or set as the default before it can be used. For Windows 9x/Me/NT, all 
profiles can appear in the printer driver by their profile descriptions (see “Defining 
profiles” on page 3-7).

NOTE: When an output profile is downloaded, it inherits the calibration target of the 
current default output profile.
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Editing profiles
The profiles on the E-820 can be customized to meet your specific needs and the 
characteristics of your copier using Color Editor, either directly or through Profile 
Manager. For more information on editing profiles, see “Color Editor” on page 3-10.

Managing profiles
Profile Manager lets you back up profiles to ensure that no custom profiles are lost 
when the E-820 software is updated. You can also upload a copy of a built-in E-820 
profile to your workstation in order to use it with an ICC-aware application, such as 
Photoshop. Profile Manager also lets you delete unwanted profiles.

NOTE: You can back up and delete only those profiles that appear in the main Profile 
Manager window without a Lock icon next to them. Locked profiles cannot be deleted, 
but most can be backed up.

TO BACK UP PROFILES

1. Start ColorWise Pro Tools and click Profile Manager.

2. Select the profile on the E-820 to upload.

The arrow in the middle of the Profile Manager window turns green and points to the 
left, indicating the profile is available for upload.

3. Click the green arrow, choose a name and location for the profile, and click Save.

The name will be the file name of the profile, but the profile description will be the 
original description, or the one you entered in the Profile Settings dialog box.

NOTE: When saving the profile on a Windows computer, be sure to include the 
extension .icm. If the extension is not included, additional dialog boxes appear.

4. Click OK when you are notified that the profile was successfully uploaded.

Delete profiles to make sure no one uses the wrong profile and to free up disk space on 
the E-820 (although profiles are small and do not take up much space).
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TO DELETE PROFILES FROM THE E-820 HARD DISK

1. Start ColorWise Pro Tools and click Profile Manager.

2. Select the profile you want to delete and click Delete.

A Warning dialog box asks you to confirm the deletion.

NOTE: You cannot delete preset profiles, profiles that are currently set as default, or 
profiles that are linked to any of the predefined custom names, for example 
Simulation-1.

3. Click Yes to delete the profile.

4. To delete a profile currently set as the default or associated with a custom name, 
click Profile Settings and clear the default option.

Defining profiles
For Windows 2000/XP and Mac OS computers, before you can apply any 
downloaded or edited profile to a print job, that profile must be linked to one of the 
predefined custom names, or you can set the profile as the default for all print jobs (see 
setting default profiles, page 3-3). Ten names are available for custom profiles—
Source-1 through 10 for RGB Source, Simulation-1 through Simulation-10 for 
Simulation, or Output-1 through Output-10 for Output. For Windows 9x/Me/NT, 
all profiles appear by their actual names in the printer driver. These fixed names are 
used in the printer driver so that you can select profiles per job even if your driver does 
not have the capability to obtain an updated list from the E-820.

NOTE: A custom simulation profile is used to illustrate this procedure. The same steps 
apply for defining custom or downloaded output profiles.
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TO DEFINE A PROFILE

1. Start ColorWise Pro Tools and click Profile Manager.

For the purposes of this example, assume DIC-new is a custom simulation profile 
created with Color Editor and, as such, no information is displayed for DIC-new 
under the heading “Appear in Driver as.” 

2. Select DIC-new in the Simulation list, and click Profile Settings or double-click 
DIC-new.

3. Select the “Appear in Driver as” option, choose one of the predefined custom 
simulation names (Simulation-1 through Simulation-10) from the menu, and then 
click Apply.

NOTE: Choose a name that is not already linked with another simulation. If you try 
to define two profiles with the same name, you will get an error message. 

For an output profile, the predefined custom names would be Output-1 through 
Output-10.

NOTE: While you cannot delete a preset profile, you can use the name of a preset 
profile name for your edited profile when you select the “Appear in Driver as” option. 
This replaces the preset profile with your own profile.

Custom profile created
with Color Editor
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When you choose Profile Settings for an output profile, the Use Calibration Set 
options also appear. You must calibrate the E-820 with this calibration set before 
this option has any effect. If you have never measured for this calibration set, default 
measurements will be used. For more information about calibration sets, see page 2-2.

In Profile Settings, you can also change profile descriptions for all non-locked profiles.

4. Click OK.

Simulation-1 now appears under the “Appear in Driver as” column for DIC-new. 
Choosing Simulation-1 from the CMYK Simulation option of the printer driver 
applies the DIC-new simulation to the print job. 

If you do not define a custom simulation profile, your job will print with CMYK 
Simulation Profile set to None. If you do not define a custom RGB Source or Output 
profile, the default profile is used.

DIC-new will appear in
driver as Simulation-1
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Color Editor
Color Editor allows you to customize simulation and output profiles. You can access 
Color Editor directly by clicking its icon in the ColorWise Pro Tools main window, or 
indirectly, through the Profile Manager.

Editing profiles
Color Editor allows you to create custom profiles by editing existing simulation or 
output profiles and saving the changes as a new profile. With Color Editor, you can 
fine-tune a profile on your E-820 to meet your exact specifications. 

NOTE: You cannot edit source profiles; only simulation and output profiles can be 
customized.

Color Editor has two Edit Modes for editing output profiles.

• Custom—Edit output profiles and save customized versions of them.

• % Density—View the calibration target, which is one component of the output 
profile. You cannot make changes to the calibration target in this window, but you 
can import a new target (see page 2-2). 

Color Editor also has several Edit Modes for editing simulations.

• Master—Create a custom master simulation that affects all print jobs to which it is 
applied, unless a linked simulation exists for the selected combination of simulation 
profile, simulation method, and output profile.

• Quick, Full (Source GCR), or Full (Output GCR)—Create custom linked simulations. 
Linked simulations affect the print job only if the corresponding simulation profile, 
simulation method, and output profile are selected. If you choose an output profile 
and simulation method for which you have created a custom linked simulation, that 
simulation is applied automatically to the job. If you choose a simulation method or 
output profile for which there is no custom linked simulation, the master simulation 
is automatically applied. For detailed information about simulation methods, see 
page 1-10.

NOTE: If you made edits to a master simulation after you created a linked simulation, 
the edits are not applied to the linked simulation.
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TO EDIT A SIMULATION PROFILE IN MASTER MODE OR AN 
OUTPUT PROFILE IN CUSTOM MODE

1. Start ColorWise Pro Tools and click Color Editor.

2. Choose Simulation or Output from the View menu.

Simulation lists the simulation profiles resident on the E-820, and Output lists the 
output profiles resident on the E-820.

3. Choose a profile to edit and click Select.

You can also open the Profile Manager, select a profile, and then click Edit.
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4. For a simulation profile, choose Master from the Edit Mode menu. For an output 
profile, choose Custom from the Edit Mode menu.

For instructions for using Quick, Full (Source GCR), or Full (Output GCR) mode, see 
page 3-16.

You can use this dialog box to view or edit profiles. The graph allows you to view and 
manipulate color output values.

NOTE: When editing an output profile in Custom mode, clicking Import at the bottom 
of the Color Editor window lets you import a calibration target file (.trg) created on 
another E-820 using the previous version of ColorWise. The current version of 
ColorWise does not allow you to save a target separately; rather, it saves the target in 
conjunction with an output profile.
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5. Select the colors you want to edit by turning colors off and on.

The Eye icon to the left of each color indicates whether that color is visible on the 
graph and will be affected by changes to the curves, brightness, and dot gain controls. 
You can view and edit all four colors (cyan, magenta, yellow, and black) at once, or any 
combination thereof. Working with only one or two colors at a time helps you fine-
tune your adjustments. To turn off a color, click its Eye icon. In the following example, 
cyan and magenta are visible and can be edited.

6. To adjust the dot gain value for simulating press output, click Dot Gain.

You can choose either the North American or European standard. Use the sliders to 
adjust to the desired Dot Gain:

• The range of values for North American at 50% input are from 0% to 50% gain 
on output. 

• The range of values for European at 40% input are from 0% to 59% gain on output; 
the range of values for European at 80% input are from 0% to 20% gain on output.
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If you use Dot Gain values, apply the settings first, so that the curves are deflected from 
their straight-line positions. Then make edits to the new curves. When you adjust Dot 
Gain values, all existing points on the curve are removed. A warning dialog box allows 
you to cancel Dot Gain settings before they are applied.

7. Use the plus and minus buttons to adjust brightness.

Changes to the brightness are reflected in the curve(s).

8. To adjust the curves directly, click and drag points on the curve or enter numbers into 
the input and output boxes.

The graph maps the input percentage to the output percentage. (These percentages 
refer to the size of the CMYK halftone dots.) The curve you selected appears, and 
points along the curve are marked so you can adjust them.

NOTE: You should adjust points in this way only after you have entered the Dot Gain 
and Brightness values.

A curve with this shape 
makes a color appear 
lighter by reducing 
density in the midtones.

A curve with this shape 
makes a color appear 
darker by adding density 
in the midtones.

A curve with this shape 
increases contrast.
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For greater precision, you can type percentages in the Input and Output boxes or use 
the arrow keys on the keyboard to adjust the curve. To use the arrow keys, you must 
first click the curve to establish an anchor point that serves as a reference.

9. For an output profile, you can set maximum densities of the C, M, Y, and K channels.

You can enter the maximum densities, called D-Max values, of individual colors for 
profiles that support density settings. D-Max settings are not available when editing 
Simulation profiles in Master mode.

10. When you are finished, click Save and enter a name for the new profile.

The new custom profile is saved to the E-820 with the new name. If you edit one of 
the press standard targets (for example, SWOP-Coated, DIC, or Euroscale), you may 
want to include the original name as part of the new target name (for example, DIC-
new) to help you remember the source of the new target.

NOTE: Preset default profiles are locked and must be saved with a new name.

For Windows 2000/XP and Mac OS computers, custom profiles must be linked to one 
of the 10 predefined custom profile names (Simulation-1 through Simulation-10 for 
Simulation or Output-1 through Output-10 for Output) in order to be accessible from 
the printer driver. You can create as many custom profiles as you want, but a maximum 
of 10 are available from the printer driver at any one time. For information on linking 
custom profiles to the predefined custom profile names, see “Defining profiles” on 
page 3-7. If you are using the printer driver for Windows 9x/Me/NT, custom profiles 
will appear in the driver window without being associated with a predefined profile 
name.

If you set a custom profile as the default, you can access it from the printer driver 
without linking it to one of the predefined custom names. Simply select “Printer’s 
default” from the printer driver.
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TO EDIT A SIMULATION IN QUICK, FULL (SOURCE GCR), OR 
FULL (OUTPUT GCR) MODE

1. Start ColorWise Pro Tools and click Color Editor.

2. Choose Simulation from the View menu, select the simulation profile to edit, and then 
click Select.

NOTE: You can also open the Profile Manager, select a simulation profile, and then 
click Edit.

3. Choose Quick, Full (Source GCR), or Full (Output GCR) from the Edit Mode menu, and 
choose an output profile with which your edited simulation will be linked from the 
Link with menu.

The edited simulation will be linked with the output profile you choose from the 
Link with menu.

NOTE: When editing a simulation profile in Quick mode, clicking Import at the 
bottom of the Color Editor window lets you import a custom Quick Simulation 
created on another E-820 using the previous version of ColorWise. The current 
version of ColorWise does not allow you to save custom Quick or Full Simulations 
independently; rather, they are saved as components of the same profile.
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4. Edit and save the simulation, as described in steps 5 through 10 of the procedure 
on page 3-13.

For this new simulation to be automatically applied to a print job, the CMYK 
Simulation, Simulation Method, and Output Profile settings must be the same as those 
used when you edited the profile. If the Simulation Method is different or a different 
output profile is selected, the Master simulation is applied.

NOTE: A Simulation Profile can have a custom Master and one or more custom links—
up to three links (Quick mode and the two Full modes) for each output profile on the 
system. (For the CMYK Simulation Profile option in the printer driver, note that if 
you select a custom profile for which the output ink percentage is greater than 0 and 
the input ink percentage is 0, the Use Master print option will have no effect.)

Undoing simulation edits
You can undo the changes you made to simulations (master and linked) in the 
following ways:

• If you have not yet saved your edits, click Done on the Color Editor menu bar 
and do not save the changes.

• If you saved your edits under a new simulation name and want to delete all edits 
(in Master, Quick, and Full modes) to the simulation, see page 3-7.

Adjusting gray balance
The AutoGray feature lets you use the copier’s built-in scanner as a measurement 
device for adjusting the gray balance of output profiles. Gray balance refers to the 
quality of neutral gray tones in a profile. In many cases, gray tones may contain a 
bluish or reddish color cast. AutoGray helps shift these tones back toward 
neutral grays. If you are satisfied with the gray balance of the copier, you do not need 
to use AutoGray.

TO CORRECT THE GRAY BALANCE OF AN OUTPUT PROFILE

1. Start ColorWise Pro Tools and click Color Editor.

2. Choose Output from the View menu.
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3. Select a profile to edit and click Select.

You can also open the Profile Manager, select a profile, and then click Edit.

4. Choose Custom from the Edit Mode menu.

5. Click AutoGray.

6. If the output profile contains no edit points, continue to step 8.
If the output profile contains edit points from a previous AutoGray session, choose an 
action from the following warning that is displayed.

Refine reuses edits points from a previous session in an attempt to make them more 
accurate. Refine is optional; use it only if the gray balance in your test document still 



33-19 Color Editor
needs improvements after the first AutoGray session. If two Refine applications cannot 
fix the situation, it is probably because your test document is not correctly addressing 
the output profile, or because the output profile that you are editing does not 
adequately describe the actual copier and printing conditions. Applying Refine more 
than twice is not recommended.

New starts a fresh AutoGray session by first removing all edit points from a previous 
session. “New” is recommended when you have performed more than two Refine 
applications. 

7. If the output profile contains edit points that were entered by a user, choose Proceed 
to remove the points and continue with the AutoGray adjustment.

Proceed starts a fresh AutoGray session by first removing all user edit points. This is 
because AutoGray cannot modify user-entered points. 

8. In the Print Options dialog box that appears, choose the Input Tray to use for the 
measurement page and click Print.

The Page Type is automatically set to AutoGray Measurement Page. 

The Paper Size is automatically set to LTR/A4.
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9. Click OK to confirm printing of the measurement page.

10. Retrieve the page from the copier.

11. Follow the directions in the dialog box for placing the Gray Scale strip and the 
AutoGray measurement page on the copier glass, and then click Continue.

Messages display the progress of the gray balance adjustment. 

12. When the adjustment is complete, click OK.

Color Editor displays the adjusted output profile curve. New edit points have been 
inserted by AutoGray to modify the gray balance, in much the same way an expert user 
would have done manually.

13. To make edits to the output profile curve, click AutoGray again.

14. Choose Refine to fine-tune the curve or New to acquire a new curve for editing.

For more information on these actions, see step 6.

Checking edited profiles
You can view a printed sample of a profile before you save it to the E-820 by printing 
one of the following:

• Comparison Page provided with ColorWise Pro Tools, which shows a comparison of 
images and colored patches with and without edits

• User-defined CALIB.PS in the Hold Queue

You can create a custom comparison page and save it as a PostScript or Encapsulated 
PostScript (EPS) file called CALIB.PS. Print the file to the Hold Queue of the E-820 
from your application, or download it to the Hold Queue with Fiery Downloader 
(see page 2-8).
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TO CHECK A PROFILE

1. Click Test Print from the Color Editor window.

2. Select a page to print, specify the paper size and input tray (Comparison Page only), 
and then click Print.

For Comparison Page, choose the paper size (LTR/A4 or 11x17/A3) from the Paper 
Size menu. In the Input Tray menu, choose the paper source.

Using Spot On (Fiery Graphic Arts Package)
The ColorWise Spot Color Matching option automatically matches spot colors with 
their best CMYK equivalents, so that spot colors can be simulated using the CMYK 
toner of the copier. However, you may want to adjust the default CMYK equivalents 
to achieve a better match for your specific printing conditions.

Spot On allows you to adjust and manage lists of spot colors and their CMYK 
equivalents. The matching lists of spot colors and CMYK values are known as Spot 
Color Dictionaries. Spot On lets you maintain multiple Spot Color Dictionaries—one 
for each output profile on the E-820.

NOTE: In order to use Spot On CMYK equivalents, you must enable the Spot Color 
Matching option (see page 1-13).
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Starting Spot On
You can start Spot On from ColorWise Pro Tools.

To work with Spot On, you must first specify the output profile associated with the 
Spot Color Dictionary that you want to edit. However, you may switch to a different 
output profile at any time while working with Spot On.

NOTE: The E-820 allows only one user connection through Spot On at a time.

TO START SPOT ON

1. Start ColorWise Pro Tools and click Spot On.

2. Choose the desired output profile and click OK.

The Spot On main window appears. The CMYK values you see in the window are 
calculated with respect to the specified profile.

Output profile names
appear here
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Using the Spot On main window
The Spot On main window displays a list of color groups which represent libraries of 
spot colors on the E-820. Tool icons for working with colors appear at the top of the 
window.

By default, the E-820 includes several PANTONE libraries along with a System 
library. The DIC, HKS, and TOYO libraries are available as part of the Fiery Graphic 
Arts Package. These factory default libraries appear marked with the default group 
icon ( ).

You can also add custom color groups and colors to the Spot On window (see 
page 3-26). Added groups appear marked with the custom group icon ( ). 
Both default and custom groups can be opened to display their included colors.

Custom color group

Up

Down

Default color group

Print

Close All

Save 

Upload 

Download 

Cut 

Paste

Copy
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TO OPEN AND CLOSE A COLOR GROUP

1. To open a color group, click the icon to the left of the group name.

You can also open a group by double-clicking the blank area to the right of the 
group name.

When you open a group, all colors in the group are displayed, and the group icon 
changes appearance.

2. To close a color group, click the icon to the left of the group name, or double-click the 
blank area to the right of the name.

3. To close all color groups in the list, choose Close All from the Edit menu. 

You can also close all color groups by clicking the Close All icon above the color list.
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Working with existing colors
With Spot On, you can view and manage existing groups of colors on the E-820. 
You can also search for a particular color in the Spot On list.

Color groups in the Spot On window appear in order of their priority. Highest priority 
is given to color groups at the top of the list. For instance, if two colors from two 
different color groups have the same name, the E-820 uses the color from the higher 
group and disregards the other color. By managing the priority of colors in this way, 
you can maintain several CMYK variants for the same spot color.

TO REARRANGE THE PRIORITY OF COLORS

1. To rearrange an entire color group, select the desired color group.

To rearrange an individual color, select the desired color.

Individual spot colors are marked with circular color icons.

2. To move the selection up or down in the list, click the Up or Down icon in the toolbar.

3. To paste the selection in a different location in the list, click the Cut or Copy icon in 
the toolbar.

NOTE: The Cut operation is only available for custom colors.

Click the location in the list where you want to paste the cut or copied selection, and 
click the Paste icon in the toolbar.

When you paste a default color group or color, a warning message may appear asking 
you to rename the selection. Use the menus to choose the desired prefix and suffix for 
the new name, and click OK. The pasted selection becomes a custom color group or 
color with the specified name.
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TO FIND A SPECIFIC COLOR

1. Choose Find from the Edit menu.

The Find dialog box appears.

2. Enter the name of the color you want to find and click OK.

Spot On searches for the specified color, starting from the top of the color list. 
The located color appears selected in the color list.

3. To find additional colors based on the same search criteria, choose Find Again from 
the Edit menu.

Creating custom colors
Spot On provides a number of default color groups, such as PANTONE and DIC, 
in the color list. You can add your own custom spot colors and groups to the list.

TO ADD A NEW COLOR OR COLOR GROUP

1. Select the line in the group or color list where your addition is intended.

2. Choose New Group from the Edit menu to insert a new group or choose New Color 
to insert a new color.

A new color group entry or color entry appears as Untitled.
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TO RENAME A CUSTOM COLOR OR COLOR GROUP

1. Select the Color Name or specific color you want to edit.

2. Type the new name exactly as it appears in the print job documents, including upper 
and lowercase characters and spaces, as needed.

NOTE: Default groups or colors (such as PANTONE) cannot be renamed.
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Downloading custom color groups
You can download custom color groups from your computer to the E-820. 
Downloaded groups are added as custom groups to the Spot On color list and are 
enabled immediately for use on the E-820.

TO DOWNLOAD CUSTOM COLOR GROUPS

1. Select the line in the color list where you want to add the downloaded group.

2. Choose Download from the File menu.

The Select File dialog box appears.

3. Locate and select the desired color group and click Open.

The downloaded group is added to the specified location in the Spot On list. If you did 
not specify a location, the group is added to the top of the list.

If the downloaded group has the same name as an existing group in the list, you are 
prompted to rename the downloaded group.
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Uploading custom color groups
You can upload custom color groups from the E-820 to your computer as ICC files. 
The upload feature allows you to share a group by creating a local copy that can be 
downloaded to another E-820.

A color group must be saved to the E-820 before you can upload it to your computer. 
To upload a factory default group, first copy and paste the group as a new custom 
group. You can then upload the group as desired.

TO UPLOAD CUSTOM COLOR GROUPS

1. Select the name of the color group you want to upload.

2. Choose Upload from the File menu.

The Save As dialog box appears.

3. Browse to the location where you want to save the file, name the file, and then 
click Save.
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Editing color values
The Spot Color Search targets the exact CMYK toner equivalents required to simulate 
a desired spot color on the copier. If an existing spot color is not printing as desired, 
you can modify the color values as needed to achieve your intended result. Beginning 
with an approximate color, you can adjust the hue, saturation, and lightness of the 
color until you achieve a desirable match.

TO TARGET A COLOR USING SPOT COLOR SEARCH

1. Select a color icon from a color group and choose Color Search from the Edit menu.

The Spot On Color Search window appears. You can also display this window by 
double-clicking a color icon in the color list.

The current color appears in the center patch of the window.

2. To update the center patch to a neighboring color that more closely matches the 
target, click the corresponding neighbor patch. 

Neighboring patches represent variations from the center patch and can be selected if 
they offer a closer match to the desired color. Clicking one of these patches updates the 
center patch to the new color and provides a new selection of neighboring colors. 
These patches are either lightness or saturation neighbors, depending on the option 
specified in the following step.

Center Patch
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NOTE: When you select certain colors, an exclamation point icon may appear in the 
upper-right corner of the window. This icon indicates that the center patch color lies at 
the edge of the copier’s printable gamut and may not be reproducible. In such cases it 
is recommended that you use an approximate target that lies within the gamut, rather 
than the out-of-gamut color.

You can also click the center patch to enter CMYK values directly. For more 
information, see the procedure on page 3-33.

3. Use the following techniques to control how neighboring color patches are generated:

Select either Lightness or Saturation in the Color Directions Legend. 

Lightness generates neighbor patches based on darker to lighter shades of the original 
color. This variation is displayed from left to right, with the original color remaining in 
the center of the middle group.

Saturation generates neighbor patches based on less saturated to more saturated 
variations of the original color. This variation is displayed from left to right, with the 
original color remaining in the center of the middle group.

Choose a setting from the Color Spacing menu to control the closeness of the neighbor 
patches. 

A higher setting generates neighbor patches that differ more noticeably from the center 
color. As you get closer to your target color, you will want to reduce the color spacing 
to a smaller value.

Select Monitor Compensation to simulate how all the on-screen color patches will 
appear when printed on paper. 

This simulation depends on the monitor profile that has been configured for the 
display. To specify the monitor profile, choose Preferences from the Edit menu in the 
Spot-On main menu.

If you use the monitor that is part of the Fiery Advanced Controller Interface option, 
select the monitor profile that is installed with the option. If you use another monitor, 
select a profile customized to describe the characteristics of that monitor.

NOTE: If you install ColorWise Pro Tools only, load the appropriate monitor profile on 
the E-820. The monitor profiles are provided in the Monitor Profiles folder on the 
CD-ROM that accompanies the Fiery Advanced Controller Interface. 

4. Continue adjusting the color patch controls and clicking neighbor patches until the 
desired color appears in the center patch. Then click Print Pattern. 
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5. Choose Output Style, Paper Size, and Paper Tray options. 

For Output Style, choose between Color Search Pattern and Color Neighbor Pattern. 
Color Search Pattern prints patches with the same pattern as displayed in the Color 
Search window. Color Neighbor Pattern prints patches in a three column by eight row 
format.

For Paper Size, choose the size of the paper you want to use for printing the patches.

For Paper Tray, specify the input tray for the paper you want to use.

6. Click OK to print the patches.

The Print Pattern test page includes the following information:

• Center patch color CMYK value

• Color spacing

• Lightness or Saturation neighbors selected

• Output profile selected

The goal of the Spot On Color Search is to find the color values that make a printed 
color patch match a target, not the screen simulation of it. Printing a Print Pattern of 
the neighbor color patches allows you to compare the printed patches to the color 
target. Once you compare the printed patches and find the one that matches most 
closely, you can then select the corresponding patch on the screen.

7. When you have selected the desired target color in the Spot On Color Search window, 
click OK.

The edited color appears in the color list of the main Spot On window.
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TO TARGET A COLOR USING EXACT CMYK VALUES

1. Click the center patch in the Spot On Color Search window.

The Set Center Patch Color dialog box appears.

2. Select how you want to enter the CMYK values. 

The Percentages option lets you enter color values between 0 and 100%, in increments 
of 0.5. Values out of this range are rounded to the nearest whole or half percentage.

The Device Codes option lets you enter color values between 0 and 255. This option 
reflects the full range of color values that the E-820 can actually reproduce, and 
provides finer gradations of color than are possible with Percentages.

3. Enter the C, M, Y, and K values of your specific color in the appropriate fields.

Use the Tab key to move from field to field. As you enter each new value, the preview 
patch updates to reflect the old and new colors.

4. Click OK.

The new color appears as the center patch in the Spot On Color Search window.
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Using a measurement instrument to target colors
If you have the EFI Densitometer ED-100, you can import measured color values 
directly into Spot On. This feature lets you target matches based on the actual colors 
of immediate objects, such as the red of a printed logo or the yellow of a packaging 
envelope.

For best results, download and save any measurement data you have gathered with the 
ED-100 in its offline state. Spot On automatically clears stored data when it establishes 
a connection with the instrument. For information on downloading stored data from 
the ED-100, see the documentation included with the instrument.

TO IMPORT COLOR MEASUREMENTS INTO SPOT ON

1. Make sure you have installed and set up the ED-100 for use with your computer.

For installation and setup instructions, see the documentation that came with the 
instrument. 

For an illustration of the ED-100, see the section beginning on page 2-16.

2. Choose Start from the Instrument menu.

The Choose Port dialog box appears.

3. For Instrument, choose the instrument you will use to take measurements. For Port, 
choose the serial port connection of the instrument. Click OK.

The indicator light on the instrument flashes for a few moments as the connection to 
Spot On is established. When the flashing stops, the instrument is ready to read 
measurements.

4. Place the ED-100 over the target color, making sure to center the sample aperture over 
the color. Press Measure to take the measurement.

The measured CMYK values are imported into Spot On as follows:

• If an individual color is selected in the color list, it updates to the measured color.

• If a group is selected in the color list, a new color with the measured values is created 
within the group.
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• If the Spot On Color Search window is open, the center patch updates with the 
measured values, and the neighbor patches update accordingly.

• If the Set Center Patch Color dialog box is open, the measured values are imported 
into the CMYK entry fields.

5. When you are finished taking color measurements, choose Stop from the 
Instrument menu.

Spot On closes the connection to the instrument.

Saving changes and exiting Spot On
To enable your spot color matches for use on the E-820, you must save your edits 
before exiting Spot On. This action ensures that all your changes to Spot On color 
definitions are stored on the E-820 and available for use when printing documents that 
contain spot colors.

The following edits do not require saving to take effect:

• Rearranging the priority level of a color group

• Downloading a color group

• Clearing or deleting a color group

TO SAVE THE SPOT ON COLOR LIST

1. Choose Save from the File menu.

2. Click Close in the upper-right corner of the Spot On main window to exit the utility.
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Color Setup
You can use Color Setup to set the default ColorWise settings for the E-820. To access 
Color Setup, click its icon in the ColorWise Pro Tools main window.

Setting default ColorWise options
Color Setup allows you to configure the default color management settings for the 
E-820. These settings are applied to all print jobs sent to the E-820, unless a user 
overrides them for an individual job by changing settings in the printer driver. 
These default settings can also be overridden using Command WorkStation or Fiery 
WebSpooler™. Color Setup maintains a connection to the E-820, so changes made in 
Profile Manager appear automatically. In addition, the defaults set in Color Setup are 
automatically reflected in other E-820 tools that list default settings.

You can also reset the E-820 to its factory default settings by clicking Factory Default 
in the lower-left corner of the Color Setup window. 

The options in Color Setup are arranged in a pattern representing the flow of color 
processing that takes place on the E-820.



33-37 Color Setup
For those color options that offer multiple choices, make your selection from the menu 
that appears. For RGB Separation, make your selection by selecting the appropriate 
radio button. Other options are selected simply by selecting a check box next to the 
option name. Once you have made your changes, you must click OK or Apply for the 
changes to take effect. Clicking OK sets the new defaults and closes the Color Setup 
window. Clicking Apply sets the new defaults and keeps the Color Setup window 
open. Clicking Cancel closes the Color Setup window without applying any changes 
to the default settings.

For most users, the factory defaults result in optimal color output.
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This appendix explains how to set up and calibrate the following color measurement 
instruments, available as separately purchased options: 

• X-Rite DTP41 automatic scanning spectrophotometer

• X-Rite DTP32 automatic scanning densitometer

Using the X-Rite DTP41 spectrophotometer
ColorWise Pro Tools Calibrator supports the X-Rite DTP41 spectrophotometer, a 
device that measures density and color data. The DTP41 communicates directly with 
the Calibrator application in ColorWise Pro Tools, sending measurements to the 
E-820 automatically.

Setting up the DTP41
Before you calibrate the E-820, you must connect, configure, and calibrate the 
spectrophotometer to prepare for measuring the printed patches. For additional 
information about setting up and using the DTP41, see the documentation included 
with the instrument.

TO CONNECT THE X-RITE DTP41 TO THE COMPUTER

1. Turn off the computer.

2. Unpack the X-Rite DTP41 and remove the spacer from the measurement page slot.

Appendix A: 
Color 
Measurement 
Instruments
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3. Plug the square end of the interface cable (looks like a modular phone plug) into the 
serial interface connection on the side of the X-Rite DTP41.

4. Attach the connector to the computer.

For a Windows computer, insert the 8-pin mini-DIN end of the interface cable into 
the 9-pin DB9 Connector cable adapter. Insert the 9-pin end into the COM1 or 
COM2 port on the computer and tighten the screws. If the available port on your 
computer is 25-pin, you must use the 8-pin-to-25-pin adapter.

Instrument button

LED indicator

Power input

Serial interface connection

Alignment mark

Calibration strip entrance

Measurement page slot

Square connectorUnused connector

Connect to computer Interface cable

Connect to adapter
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For a Mac OS computer, connect the 8-pin mini-DIN plug directly into the serial port 
of the computer.

NOTE: For Mac OS computers with a USB port (for example, an iMac), you need an 
adapter to connect the DTP41 to your computer. For information on supported 
adapters, see the X-Rite, Inc. web site (www.x-rite.com).

5. Use the AC adapter to provide power.

Plug the small connector on the adapter cable into the power input of the X-Rite 
DTP41 and plug the AC adapter into the power cord. Plug the power cord into a 
wall outlet.

Unused connector

Connect to serial port

AC adapter

Small connector

Power cord

http://www.x-rite.com
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6. Turn on the computer.

7. Calibrate the X-Rite DTP41 using ColorWise Pro Tools (see the following section).

8. Calibrate the E-820 using ColorWise Pro Tools and the DTP41 (see page 2-10). 

Calibrating the DTP41
For the most accurate color, you should calibrate the X-Rite DTP41 
spectrophotometer every time you calibrate the E-820. You can initiate the 
calibration sequence in ColorWise Pro Tools Calibrator as part of the process of 
E-820 calibration. The computer may also prompt you that it is necessary to 
calibrate the spectrophotometer. 

Alternatively, you can initiate the DTP41 calibration process using the Instrument 
button on the DTP41. For more information on this method, see the documentation 
that came with the X-Rite DTP41. 

Multiple users can be connected to one E-820 server with ColorWise Pro Tools, but 
only one user at a time can use the Calibrator module. An error message appears if you 
try to calibrate when another user is already using ColorWise Pro Tools to calibrate.

You will need the Color Reflection Reference strip that is included with the 
spectrophotometer. Remove the strip from its protective envelope, handling it by the 
edges only. Keep the strip free of dust and smudges and always store it in the protective 
envelope.

TO CALIBRATE THE X-RITE DTP41

1. Connect the spectrophotometer to the computer and turn on power (see page A-1).

2. Start Calibrator.

For instructions on starting Calibrator, see page 2-6.
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3. Choose DTP41 as the measurement method.

4. In the Get Measurements pane, click Measure. 

5. In the Measurement Options dialog box, click Measure.

6. Choose the appropriate COM port for the DTP41 from the Available Ports menu.

The Instructions area displays instructions for selecting the port.
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7. Click Utilities.

The Utilities dialog box appears. 

To view version and serial number information, click Show DTP-41 Info and click 
Done when you are finished.

8. Click Calibrate DTP-41.

The Instrument Calibration dialog box appears.
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9. If you have not already done so, remove the shipping spacer from the measurement 
page slot.

10. Insert the end of the Color Reflection Reference strip with the arrow into the calibra-
tion strip entrance on the DTP41, centering it below the alignment mark (see the dia-
gram on page A-2).

Insert the strip about 3 inches, past the front idler rollers, until it rests against the rear 
drive rollers.

11. Click Read Reference in the Instrument Calibration dialog box.

The DTP41 pulls the calibration strip through automatically.

A message appears in the Status area when the calibration is finished.

12. Click Done.

13. Close the Utilities window.

This completes DTP41 calibration.

When the DTP41 requires calibration, your computer prompts you. When the 
prompt message appears, click Calibrate Now and follow the instructions, starting 
with step 8 on page A-6.

After calibrating the DTP41, calibrate the E-820 (see page 2-10). 

Using the X-Rite DTP32 densitometer
ColorWise Pro Tools are designed to work with the X-Rite DTP32 reflection 
densitometer, which feeds color measurements to the E-820 automatically. 

NOTE: Measurements from other densitometers can be input using a simple 
ASCII file format (see Appendix B). 
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Setting up the DTP32
Before you calibrate the E-820 using the X-Rite DTP32, you need to connect, 
configure, and calibrate the densitometer to prepare for measuring the printed patches 
(see “Calibrating the DTP32” on page A-10). For additional information about setting 
up and using the DTP32, see the separate documentation included with the 
densitometer. 

TO CONNECT THE X-RITE DTP32 TO THE COMPUTER

1. Turn off the computer.

2. Plug the square end of the interface cable (looks like a modular phone plug) into the 
I/O port on the side of the X-Rite DTP32.

3. Attach the connector to the computer.

For a Windows computer, insert the 8-pin mini-DIN end of the interface cable into 
the 9-pin DB9 Connector cable adapter. Insert the 9-pin end into the COM1 or 
COM2 port on the computer and tighten the screws. If the available port on your 
computer is 25-pin, you must use the 8-pin-to-25-pin adapter.

Square connector

Square connector
Unused connector

Connect to computer

Interface cableConnect to adapter
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For a Mac OS computer, connect the 8-pin mini-DIN plug directly into the serial port 
of the computer.

NOTE: For Mac OS computers with a USB port (for example, an iMac), you need an 
adapter to connect the DTP32 to your computer. For information on supported 
adapters, see the X-Rite, Inc. web site (www.x-rite.com).

4. Plug the small connector on the adapter cable into the side of the X-Rite DTP32 and 
plug the AC adapter into a wall outlet.

5. Turn on the computer.

6. Calibrate the DTP32 (see the following section).

7. Calibrate the E-820 using ColorWise Pro Tools (see page 2-21). 

Unused connector

Connect to serial port

AC adapter

Small connector
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Calibrating the DTP32
You will need the black-and-white X-Rite Auto-Cal Strip included with the 
densitometer. Calibrating the densitometer does not require ColorWise Pro Tools.

TO CALIBRATE THE X-RITE DTP32

1. Connect the densitometer to the computer and supply power (see page A-7).

2. From the Main Menu on the X-Rite DTP32 display, press the p1 key once to reach p2.

3. Press the cal key.

Calibrating motor speed is displayed, followed by the words INSERT CAL STRIP.

4. Insert the arrow end of the X-Rite Auto-Cal Strip into the 35mm slot on the front of 
the X-Rite DTP32 until it stops or the roller starts pulling the strip.

Reading appears momentarily, followed by the density values and CALIBRATION OK. 
The densitometer automatically returns to the MAIN MENU.

If UNRECOGNIZABLE STRIP appears, repeat the process or try cleaning the strip (see the 
X-Rite DTP32 Operating Manual).

5. Start ColorWise Pro Tools and calibrate the E-820 (see the following section). 

Recalibrate the DTP32 at least once per month. For critical color, calibrate the 
densitometer every time you calibrate the E-820. The DTP32 may also warn 
periodically that it requires calibration.
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This appendix describes Simple ASCII File Format, which can be used to import 
density measurements from measurement devices. To use your own measurement data 
from an alternate measurement instrument, record your individual readings in a text 
file and structure it as follows.

Simple ASCII Import File Format (SAIFF)
This format describes Status T measurement data and is for import into the 
ColorWise Pro Tools Calibrator. The three possible file formats are:

• 1D Status T density for EFI 34 patch page

• 1D Status T density for EFI 21 patch page

• 1D Status T density for other pages (maximum of 256 patches per ink)

The file format is ASCII and has no tabs. A single space or multiple spaces are used 
as delimiters. Blank lines are not allowed. Each line in the file represents four patches 
(C, M, Y, K) of a specific ink value. Comments may be on any line in the file, and 
these lines start with a pound sign (#) followed by a space. A line with a pound sign 
followed by any character other than a space has been reserved. Comments must be 
on an entire line by themselves.

Each line of data contains five values. The first number is the sequential patch number 
(for EFI 34 and EFI 21 pages) or the ink value percentage (for other pages). The four 
values that follow are the density values of C, M, Y, and K of the corresponding patch. 
Lines are ordered either by increasing sequential patch numbers or by increasing the 
ink percentage.

For Windows computers, the file extension must be .cm1. For Mac OS computers, the 
file type must be ‘TEXT’.

Measurement data in EFI 34 and EFI 21 are paper-relative. For other pages, if the first 
line corresponds to zero ink value, the Calibrator assumes that the measurement data is 
absolute and adjusts it to become paper-relative by subtracting the density values of the 
first line from the remaining patches.

Appendix B: 
Importing 
density 
measurements
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Example of 1D Status T density for EFI 34 patch page
This file format is used to specify the Status T density measurements of the EFI 34 
patch page. The value in the first column is the patch number. The first patch must be 
1 and the last must be 34.

#!EFI 3
# EFI ColorWise 2.0 Data
type: 1DST34
# Cyan   Magent Yellow Black
1 0.0300 0.0400 0.0200 0.0400
2 0.0600 0.0700 0.0800 0.0700
3 0.1000 0.1000 0.1000 0.1000
(…more data…)
33 1.6700 1.3400 0.8900 1.6700
34 1.7200 1.4300 0.9300 1.7500

Example of 1D Status T density for EFI 21 patch page
This file format is used to specify the Status T density measurements of the EFI 21 
patch page. The value in the first column is the patch number. The first patch must be 
1 and the last must be 21.

#!EFI 3
# EFI ColorWise 2.0 Data
type: 1DST21
# Cyan   Magent Yellow Black
1 0.0300 0.0400 0.0200 0.0400
2 0.0600 0.0700 0.0800 0.0700
3 0.1000 0.1000 0.1000 0.1000
(…more data…)
20 1.6700 1.3400 0.8900 1.6700
21 1.7200 1.4300 0.9300 1.7500
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Example of 1D Status T density for an arbitrary page
This file format is used to specify the Status T density measurements of a user-defined 
patch page. The value in the first column is the ink/toner percentage of the patch. The 
first percentage must be 0 and the last percentage must be 100. The percentages must 
increase in between. 

#!EFI 3
# EFI ColorWise 2.0 Data
type: 1DST
# percnt Cyan Magent Yellow Black
0.0000 0.0300 0.0400 0.0200 0.0400
0.3922 0.0600 0.0700 0.0800 0.0700
1.1765 0.1000 0.1000 0.1000 0.1000
(…more data…)
98.0000 1.6700 1.3400 0.8900 1.6700
100.0000 1.7200 1.4300 0.9300 1.7500
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